Note:
The contents of the Guest Operating System Installation Guide have changed. The new version of this guide contains information and instructions applicable only to installing guest operating systems. For guest operating system support data, see the new Guest/Host OS VMware Compatibility Guide. For VMware Tools information, see the applicable product documentation on the VMware Documentation Web site http://www.vmware.com/support/pubs/.
For known issues, see the VMware Knowledge Base located at http://kb.vmware.com/.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
# Contents

## About This Book  9

## Installing Guest Operating Systems  11

- Latest Updates  11
- General Guidelines for Supported Guests  12
  - Determining Memory Settings for a Virtual Machine  12
  - Sound Adapters on GSX and VMware Servers  12
  - Running a Guest Operating System  12
  - 64-Bit Linux Guests and Execute Disable Functionality  12
- General Installation Instructions for All VMware Products  12
  - Typical Installation  12
  - ISO Installation  13
  - PXE Installation  13

### Windows 7  14
- Installation Steps  14
- VMware Tools  14

### Windows Preinstallation Environment  15
- Installation Steps  15
- VMware Tools  15

### Windows Recovery Environment  16
- VMware Tools  16

### Windows Server 2008 R2  17
- Installation Steps  17
- VMware Tools  17

### Windows Server 2008  18
- Installation Steps  18
- VMware Tools  18

### Windows Vista  19
- Installation Steps  19
- VMware Tools  19

### Windows Server 2003  20
- Installation Steps  20
- VMware Tools  20

### Windows XP  21
- Installation Steps  21
- VMware Tools  21

### Windows 2000  22
- Installation Steps  22
- VMware Tools  22

### Windows NT 4.0  23
- Installation Steps  23
- Post Installation Instructions  23
  - Enabling Networking After Installing Windows NT 4.0  23
  - VMware Tools  24

### Windows Me  25
- Installation Steps  25
- VMware Tools  25

### Windows 98  26
Guest Operating System Installation Guide

- Installation Steps 26
- Post Installation Instructions 26
  - Enabling Networking After Installing Windows 98 26
- VMware Tools 26

Windows 95 27
- Installation Steps 27
- Post Installation Instructions 28
- VMware Tools 28

MS-DOS 6.22 and Windows 3.1x 29
- MS-DOS 6.22 and Windows 3.1x Installation 29
- Post Installation Considerations for MS-DOS 6.22 and Windows 3.1x 30
- VMware Tools 30

Asianux Server 3.0 31
- Installation Steps 31
- VMware Tools 31

CentOS 5.0 32
- Installation Steps 32
- VMware Tools 32

CentOS 4.0 33
- Installation Steps 33
- VMware Tools 33

Debian 5.0 34
- Installation Steps 34
- VMware Tools 34

Debian 4.0 35
- Installation Steps 35
- VMware Tools 35

eComStation 1.0 36
- Installation Steps 36
- VMware Tools 36

IBM OS/2 Warp 4.5.2 37
- Installation Steps 37
  - Create Boot Disks 37
- VMware Tools 38

IBM OS/2 Warp 4.0 39
- Installation Steps 39
  - Create Boot Disks 39
- VMware Tools 40

Mac OS X Server 10.5 41
- Installation Steps 41
- VMware Tools 42

Mandriva Corporate 4 43
- Installation Steps 43
- VMware Tools 43

Mandriva Linux 2009 44
- Installation Steps 44
- VMware Tools 44

Mandriva Linux 2008 45
- Installation Steps 45
- VMware Tools 45

Mandriva Linux 2007 46
- Installation Steps 46
- VMware Tools 46

Mandriva Linux 2006 47
- Installation Steps 47
Install and Configure SMP  75
VMware Tools  75
SUSE Linux Enterprise 11  76
  Installation Steps  76
  VMware Tools  76
SUSE Linux Enterprise 10  77
  Installation Steps  77
  VMware Tools  77
SUSE Linux Enterprise Server 9  78
  Installation Steps  78
  VMware Tools  78
SUSE Linux Enterprise Server 8  79
  Installation Steps  79
  VMware Tools  79
SUSE Linux Enterprise Server 7  80
  Installation Steps  80
  VMware Tools  80
openSUSE Linux 11.1  81
  Installation Steps  81
  VMware Tools  81
openSUSE Linux 10.3  82
  Installation Steps  82
  VMware Tools  82
openSUSE Linux 10.2  83
  Installation Steps  83
  VMware Tools  83
SUSE Linux 10.1  84
  Installation Steps  84
  VMware Tools  84
SUSE Linux 10.0  85
  Installation Steps  85
  VMware Tools  85
SUSE Linux 9.3  86
  Installation Steps  86
  VMware Tools  86
SUSE Linux 9.2  87
  Installation Steps  87
  VMware Tools  87
SUSE Linux 9.1  88
  Installation Steps  88
  VMware Tools  88
SUSE Linux 9.0  89
  Installation Steps  89
  VMware Tools  89
SUSE Linux 8.2  90
  Installation Steps  90
  VMware Tools  90
SUSE Linux 8.1  91
  Installation Steps  91
  VMware Tools  91
SUSE Linux 8.0  92
  Installation Steps  92
  VMware Tools  92
SUSE Linux 7.3  93
  Installation Steps  93
VMware Tools 93
Turbolinux 10 94
Installation Steps 94
VMware Tools 94
Turbolinux 8 95
Installation Steps 95
VMware Tools 95
Turbolinux 7.0 96
Installation Steps 96
VMware Tools 96
Ubuntu 9.10 97
Installation Steps 97
VMware Tools 97
Ubuntu 9.04 98
Installation Steps 98
VMware Tools 98
Ubuntu 8.10 100
Installation Steps 100
VMware Tools 100
Ubuntu 8.04 LTS 102
Installation Steps 102
VMware Tools 102
Ubuntu Linux 7.10 104
Installation Steps 104
VMware Tools 104
Ubuntu Linux 7.04 106
Installation Steps 106
VMware Tools 106
Ubuntu Linux 6.10 107
Installation Steps 107
VMware Tools 107
Ubuntu Linux 6.06 108
Installation Steps 108
VMware Tools 108
Ubuntu Linux 5.10 109
Installation Steps 109
VMware Tools 109
VMware Tools and 64-bit Version of Ubuntu Linux 5.10 109
Ubuntu Linux 5.04 110
Installation Steps 110
VMware Tools 110
FreeBSD 7 111
Installation Steps 111
VMware Tools 111
FreeBSD 6 112
Installation Steps 112
VMware Tools 112
FreeBSD 5 113
Installation Steps 113
VMware Tools 113
FreeBSD 4 114
Installation Steps 114
Additional Install Instructions for FreeBSD 4.11, 4.10, and 4.9 114
Additional Install Instructions for FreeBSD 4.3, 4.2, 4.1, and 4.0 114
VMware Tools 116
NetWare 6.5 Server  117  
  Installation Steps  117  
  VMware Tools  118
NetWare 6.0 Server  119  
  Installation Steps  119  
  VMware Tools  120
NetWare 5.1 Server  121  
  Installation Steps  121  
  VMware Tools  122
NetWare 4.2 Server  123  
  Installation Steps  123  
  VMware Tools  124
Solaris 10 Operating System for x86 Platforms  125  
  Installation Steps  125  
  VMware Tools  125
Solaris 9 Operating System x86 Platform Edition  126  
  Installation Steps  126  
  VMware Tools  127
Solaris 8 Operating System x86 Platform Edition  128  
  Installation Steps  128  
    Adding a SCSI Driver  129  
  VMware Tools  129

Index  131
About This Book

The Guest Operating System Installation Guide provides users of VMware® ESX Server, VMware GSX Server, VMware Server, VMware ACE, VMware Workstation, and VMware Fusion™ information about installing guest operating systems in VMware virtual machines.

Revision History

This guide is revised with each newly supported guest operating system that requires installation instructions.

Table 1. Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20100304</td>
<td>■ Added information about recommended memory size for Windows 95.</td>
</tr>
<tr>
<td></td>
<td>■ Added information about kernel panic error when installing 64-bit Red Hat Enterprise Linux AS 4.0, 4.1, and 4.2 on a host with AMD NPT processor.</td>
</tr>
<tr>
<td></td>
<td>■ Removed incorrect instructions for enabling root on an Ubuntu Desktop 9.10 virtual machine.</td>
</tr>
<tr>
<td></td>
<td>■ Condensed installation instructions for Desktop and Server releases for Linux guests, including Mandriva Corporate 4, SUSE Linux Enterprise 11,</td>
</tr>
<tr>
<td></td>
<td>SUSE Linux Enterprise 10, Turbolinux 10, and Turbolinux 8.</td>
</tr>
<tr>
<td></td>
<td>■ Condensed installation instructions for Mandrake 9.x and 8.x.</td>
</tr>
<tr>
<td></td>
<td>■ Condensed installation instructions for RedHat Linux 7.x.</td>
</tr>
<tr>
<td></td>
<td>■ Condensed installation instructions for FreeBSD 7.x, 6.x, 5.x, and 4.x.</td>
</tr>
<tr>
<td>20100201</td>
<td>■ Modified hard drive requirements for a Windows 2008 r2 virtual machine.</td>
</tr>
<tr>
<td></td>
<td>■ Added information about support for the e1000 NIC driver for Windows XP on ESX 4.0 Update 1.</td>
</tr>
<tr>
<td></td>
<td>■ Added instructions for eComStation 1.0.</td>
</tr>
<tr>
<td></td>
<td>■ Added instructions for Mandriva 2009.</td>
</tr>
<tr>
<td></td>
<td>■ Revised guest selections for creating virtual machines on SUSE Linux Enterprise Server 10 and SUSE Linux Enterprise Server 9 with OES 1 and</td>
</tr>
<tr>
<td></td>
<td>OES2 support.</td>
</tr>
<tr>
<td></td>
<td>■ Revised VMware Tools support for Solaris 10 Operating System for x86 Platforms.</td>
</tr>
<tr>
<td>20091119</td>
<td>■ Added new instructions for Windows Server 2008 r2, Oracle Enterprise Linux 4, Ubuntu 9.10, and FreeBSD 7.2.</td>
</tr>
</tbody>
</table>
### Intended Audience

This guide is for those responsible for installing operating systems on VMware virtual machines.

### Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to docfeedback@vmware.com.

### Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current version of this book and other books, go to [http://www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).

#### Online and Telephone Support

To use online support to submit technical support requests, view your product and contract information, and register your products, go to [http://www.vmware.com/support](http://www.vmware.com/support).

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to [http://www.vmware.com/support/phone_support.html](http://www.vmware.com/support/phone_support.html).

#### Support Offerings

To find out how VMware support offerings can help meet your business needs, go to [http://www.vmware.com/support/services](http://www.vmware.com/support/services).

#### VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment. To access information about education classes, certification programs, and consulting services, go to [http://www.vmware.com/services](http://www.vmware.com/services).
Installing Guest Operating Systems

The Guest Operating System Installation Guide includes installation instructions for installing supported guest operating systems on the following VMware products:

- VMware ESX Server 2.0 and later
- VMware ESXi/ESX 3.5 and later
- VMware Workstation 4.0 and later
- VMware Server 1.0 and later
- VMware Fusion 1.0 and later
- VMware ACE 1.0 and later
- VMware GSX Server 3.0 and later

If you are using VMware® Workstation 3.x, VMware GSX Server 2.x, VMware ESX Server 1.x or an earlier VMware product, see the user’s manual that came with your product for installation instructions for the guest operating systems supported by that product.

Operating systems that are not included in this guide are not supported.

See “General Installation Instructions for All VMware Products” on page 12 for information that might apply to the guest you are installing and see “Latest Updates” on page 11 for the most recent changes to this guide.

Latest Updates

Find the latest version of the guide on the VMware Web site at: http://www.vmware.com/support/pubs. Check the date on the cover page to determine if your copy of the guide is current. These are the changes or updates made to the Guest Operating System Installation Guide since it was last published.

- Added information about recommended memory size for Windows 95. See “Windows 95” on page 27.
- Added information about kernel panic error when installing 64-bit Red Hat Enterprise Linux AS 4.0, 4.1, and 4.2 on a host with an AMD NPT processor. See “Red Hat Enterprise Linux 4” on page 57.
- Condensed installation instructions for Desktop and Server releases for Linux guests, including “Mandriva Corporate 4” on page 43, “SUSE Linux Enterprise 11” on page 76 and “SUSE Linux Enterprise 10” on page 77, “Turbolinux 10” on page 94 and “Turbolinux 8” on page 95.
- Condensed installation instructions for Mandrake 9.x and 8.x. Start with “Mandrake Linux 9” on page 49.
- Condensed installation instructions for RedHat Linux 7.x. See “Red Hat Linux 7” on page 67.
- Condensed installation instructions for FreeBSD 7.x, 6.x, 5.x, and 4.x. Start with “FreeBSD 7” on page 111.
General Guidelines for Supported Guests

Configurations, support, and hardware influence how you install a supported guest operating system.

Determining Memory Settings for a Virtual Machine

When you configure the memory settings for a virtual machine, you should consult the documentation for the guest operating system you plan to run in that virtual machine. The user interface of your VMware product provides general guidelines for the amount of memory required. If the interface and the operating system documentation do not agree, you should rely on the operating system documentation.

Sound Adapters on GSX and VMware Servers

Sound adapters by default are not installed in a virtual machine for GSX or VMware Servers. To add a sound adapter, use the virtual machine settings editor (VM > Settings) after you have installed the operating system. For instructions on configuring sound for a virtual machine on a GSX or VMware Server, see the corresponding server documentation.

Running a Guest Operating System

For information about running a guest operating system and using its features, see the documentation provided by the operating system vendor.

64-Bit Linux Guests and Execute Disable Functionality

When running a 64-bit Linux guest operating system on EM64T hardware, make sure that you have Execute Disable functionality enabled in the host BIOS. This helps to ensure that the Linux guest operating system runs without interruption.

General Installation Instructions for All VMware Products

Before installing a guest operating system, create a virtual machine and ensure that its devices are setup correctly. For example, install networking software when you install the guest operating system, and configure and enable the Ethernet adapter for the virtual machine.

The tool or interface you used to configure the virtual machine depends on the VMware product you are running.

A new virtual machine is like a physical computer with a blank hard disk. Before you can use it, you must partition and format the virtual disk and install an operating system. The operating system installation program might handle the partitioning and formatting steps for you.

**NOTE** You should disable screen savers that might be running on the host system before you install the guest operating system.

Installing a guest operating system in a virtual machine is essentially the same as installing it on a physical computer.

Typical Installation

The basic steps to install a typical operating system:

1. Start your VMware product and connect to the virtual machine.
2. Insert the installation CD-ROM or disc of the guest operating system in to the CD-ROM or disc drive connected to the virtual machine.

**ESX Server 2.x:** You must insert the installation CD-ROM or disc in the drive on the server where the virtual machine is running. You cannot use the drives on the management workstation.
**GSX Server:** If your guest operating system requires a disc, you must insert it in the drive on the server where the virtual machine is running. You cannot use the disc drive on the management workstation.

3 Turn on your virtual machine by clicking the **Power On** button.

4 Follow the instructions provided by the operating system vendor.

As with physical computers, operating systems require separate licenses for each virtual machine you run.

**NOTE** Some Microsoft Windows OEM discs included with new computers are customized for those computers and include device drivers and other utilities specific to the hardware system. Even if you can install this Windows operating system on your physical computer, you might not be able to install it in a virtual machine. You might need to purchase a new copy of Windows to install in a virtual machine.

**ISO Installation**

Rather than boot from a physical CD-ROM, you can create an ISO image file from the installation CD-ROM. You can store the ISO file on the host machine or on a network drive accessible from the host machine. Use the configuration tool for your VMware product to connect the virtual machine CD drive to the ISO image file, and turn on the virtual machine.

Using an ISO image file is convenient to install the same operating system in multiple virtual machines. It can also help you work around a problem seen in host configurations, in which the virtual machine is unable to boot from the installation CD-ROM.

**PXE Installation**

If you plan to use a PXE server to install the guest operating system over the network, you do not need the operating system installation media. When you turn on the virtual machine, the virtual machine detects the PXE server.
Windows 7

Read "General Guidelines for Supported Guests" on page 12 and this section before installing this operating system.

Install Windows 7 in a virtual machine using the corresponding Windows 7 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 7:

- Create and configure a new virtual machine.
- Make sure the virtual machine has at least 1GB of RAM or more for 32-bit guests and 2GB or more of RAM for 64-bit guests.
- For the 32-bit version of Windows 7, the hard drive for the virtual machine must be 24GB or larger.
- For the 64-bit version of Windows 7, the hard drive for the virtual machine must be 32GB or larger.

Installation Steps

1. Insert the Windows 7 CD or DVD in the CD-ROM drive.
2. Turn on the virtual machine to begin installing Windows 7.
3. Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Install VMware Tools in your guest operating system. For an overview of VMware Tools and for a list of the manuals that contain installation instructions for VMware Tools, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Windows Preinstallation Environment

Read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

Fulfill these prerequisites before installing Windows Preinstallation Environment:

- Create and configure a new virtual machine.
- Select Windows Vista for the guest operating system selection. A Windows PE selection is not available.
- Download Windows AIK 1.1 (WAIK1.1) software (build from Windows Server 2008 kernel) from the Microsoft Web site:
- Create a Windows PE 2.1 ISO image.

To create a Windows PE 2.1 ISO image

2. Select Start > All Programs > Microsoft Windows AIK > Windows PE Tools Command Prompt to open the Windows PE Tools Command Prompt.
3. Type one of the following commands to create a Windows PE build environment for an x86 or amd64 machine in the winpe-x86 folder.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit</td>
<td>copy x86 C:\winpe-x86</td>
</tr>
<tr>
<td>64-bit</td>
<td>copy amd64 C:\winpe-amd64</td>
</tr>
</tbody>
</table>

4. Create a Windows PE 2.1 bootable ISO image by entering the following command:

  oscdimg -n -h -bc:\winpe-x86\etfsboot.com c:\winpe-x86\iso c:\winpe-x86\winpe-x86.iso

Installation Steps

1. Boot the virtual machine from a Windows PE 2.1 ISO image.
2. After the boot process completes, a command prompt appears.
   Use Windows PE to prepare your virtual machine to install a Windows operating system.

VMware Tools

There is no version of VMware Tools that supports Windows Preinstallation Environment.
Windows Recovery Environment

Read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

For instructions specific to the Windows Recovery Environment, see the accompanying operating system documentation.

VMware Tools

There is no version of VMware Tools that supports Windows Recovery Environment.
Windows Server 2008 R2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install the Windows Server 2008 R2 in a virtual machine using the Windows Server 2008 R2 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Server 2008 R2:

- Create and configure a new virtual machine.
- Ensure that the virtual machine has at least 512MB of RAM. The host computer must have more than 512MB of RAM to support this setting.

Installation Steps

1. Insert the Windows Server 2008 R2 CD in the CD-ROM drive.
3. Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
**Windows Server 2008**

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install the Windows Server 2008 in a virtual machine using the Windows Server 2008 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Server 2008:

- Create and configure a new virtual machine.
- Ensure that the virtual machine has at least 512MB of RAM. The host computer must have more than 512MB of RAM to support this setting.
- For the 32-bit version of Windows Server 2008, the hard drive for the virtual machine must be 16GB or larger.
- For the 64-bit version of Windows Server 2008, the hard drive for the virtual machine must be 24GB or larger.

Consider these support and configuration issues for Windows Server 2008:

- If an Internet connection is not available while installing a 32-bit Windows Server 2008 guest, the driver for the multimedia audio controller will not be installed. The Windows Device Manager will indicate that the driver for the multimedia audio controller is missing. To install the required driver, configure an Internet connection, and run Windows Update on the Windows Server 2008 virtual machine.
- The Server Core role available in the Standard, Datacenter, and Enterprise editions of Windows 2008 Server is supported by ESX. VMware Tools still apply, unless Server Core disables parts of the operating system that are specifically supported by VMware Tools. See the Microsoft Developer Network Web site for more information about Server Core: [http://msdn.microsoft.com/en-us/library/ms723891(VS.85).aspx](http://msdn.microsoft.com/en-us/library/ms723891(VS.85).aspx)

**Installation Steps**

1. Insert the Windows Server 2008 CD in the CD-ROM drive.
3. Follow the remaining installation steps as you would for a physical machine.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
**Windows Vista**

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows Vista in a virtual machine using the corresponding Windows Vista distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Vista:

- Create and configure a new virtual machine.
- Make sure the virtual machine has at least 512MB of RAM. The host computer must have more than 512MB of RAM to support this setting.
- For the 32-bit version of Windows Vista, the hard drive for the virtual machine must be 16GB or larger.
- For the 64-bit version of Windows Vista, the hard drive for the virtual machine must be 24GB or larger.

Consider these support and configuration issues for Windows Vista:

- If an Internet connection is not available while installing a 32-bit Windows Vista guest, the driver for the multimedia audio controller will not be installed. The Windows Device Manager will indicate that the driver for the multimedia audio controller is missing. To install the required driver, configure an Internet connection, and run Windows Update on the Windows Vista virtual machine.

**Installation Steps**

1. Insert the Windows Vista CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Windows Vista.
3. Follow the remaining installation steps as you would for a physical machine.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

**NOTE** After installing VMware Tools on a Windows Vista Service Pack (SP1) virtual machine, the screen resolution does not change to 1024 by 768 pixels automatically. See knowledge base article 1004780 at [http://kb.vmware.com/kb/1004780](http://kb.vmware.com/kb/1004780).
Windows Server 2003

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows Server 2003 in a virtual machine using the corresponding Windows Server 2003 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Server 2003:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows Server 2003:

- If an Internet connection is not available while installing a Windows Server 2003 guest, the driver for the multimedia audio controller will not be installed. The Windows Device Manager will indicate that the driver for the multimedia audio controller is missing. To install the required driver, configure an Internet connection, and run Windows Update on the Windows Server 2003 virtual machine.

- If you are using the virtual LSI Logic SCSI adapter, Windows Server 2003 automatically installs the SCSI driver when you install the guest operating system. If you are using the virtual BusLogic SCSI adapter, you need a special SCSI driver available from the download section of the VMware Web site at www.vmware.com/download. Follow the instructions on the Web site to use the driver with a fresh installation of Windows Server 2003.

- If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system and want to upgrade it to Windows Server 2003, install the new SCSI driver before upgrading the operating system.

- You need to manually configure the e1000 network adapter driver in ESX 3.0.2 to support Windows Server 2003 Datacenter Edition. Refer to knowledge base article 1003020 at http://kb.vmware.com/kb/1003020.

Installation Steps

1. Insert the Windows Server 2003 CD in the CD-ROM drive.
3. If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site, you must take some special steps at this point in the installation process.
4. As the Windows Server 2003 installer loads, press the F6 key.
   This allows you to select the additional SCSI driver required for installation.
5. Press S to specify the additional driver.
6. After you specify the SCSI driver, press Enter to continue with setup.
7. Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Windows XP

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows XP Home Edition or Professional in a virtual machine using the corresponding Windows XP distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows XP:

- Create and configure a new virtual machine

Consider these support and configuration issues for Windows XP:

- **ESX, VMware Workstation, VMware ACE, and GSX Server**: To use the virtual BusLogic SCSI adapter in a Windows XP virtual machine, you need a special SCSI driver available from the download section of the VMware Web site at [www.vmware.com/download](http://www.vmware.com/download). Follow the instructions on the Web site to use the driver with a fresh installation of Windows XP.

- **ESX and GSX Server**: If you are using the virtual LSI Logic SCSI adapter in a Windows XP virtual machine, download the driver from the download center at the LSI Logic Web site. Go to [http://wwwlsi.com/](http://wwwlsi.com/) and download the lsi20320-R SCSI adapter driver for your guest operating system.

  The LSI Logic Web site also provides a guide for installing the drivers. Go to [http://wwwlsi.com/](http://wwwlsi.com/). Select **Support & Downloads > Documentation**. Enter the search term **Fusion MPT** to find the **Fusion-MPT Device Management User Guide**.

- **ESX**: You can use the vmscsi SCSI driver for the virtual BusLogic SCSI adapter provided on the Windows XP Professional floppy image that is included with the ESX software. Although supported by ESX 4.0 Update 1, the e1000 NIC driver is not provided with the 32-bit version of Windows XP Professional. For support, download the driver from the Intel Web site. See knowledgebase article 1016456 at [http://kb.vmware.com/kb/1016456](http://kb.vmware.com/kb/1016456).

  If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system, and want to upgrade the virtual machine to Windows XP, install the new SCSI driver before upgrading the operating system.

### Installation Steps

1. Insert the installation CD in the CD-ROM drive.

2. Power on the virtual machine to start installing the guest operating system.

   If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site or the LSI Logic SCSI driver downloaded from the LSI Logic Web site, you must take some special steps at this point in the installation process.

3. As the Windows XP installer loads, press the F6 key.

   This allows you to select the additional SCSI driver required for installation.

4. Press S to specify the additional driver, and press Enter to continue with the setup.

5. Follow the installation steps as you would for a physical machine.

### VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
Windows 2000

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install a supported version of Windows 2000 in a virtual machine using the corresponding Windows 2000 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 2000:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows 2000:

- **ESX Server, VirtualCenter, or vCenter Server:** If you are using the virtual LSI Logic SCSI adapter, you must download the driver from the download center at the LSI Logic Web site. Go to [http://wwwlsi.com/cm/DownloadSearch.do?locale=EN](http://wwwlsi.com/cm/DownloadSearch.do?locale=EN) and download the LSI20320-R SCSI adapter driver for your guest operating system.

**Installation Steps**

1. Insert the Windows 2000 CD in the CD-ROM drive.
3. Follow the installation steps as you would for a physical machine.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

After you install VMware Tools, change the Windows 2000 screen area to be greater than 640x480 pixels; if you do not change it, Windows 2000 uses the standard VGA driver, and performance will suffer.
Windows NT 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows NT 4.0 (Workstation or Server) in a virtual machine using the standard Windows NT CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows NT 4.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows NT 4.0:

- To set up a virtual machine running Windows NT 4.0 and using multiple disks, you must first create a virtual machine with only one disk. Install Windows NT on that disk. Then use the configuration tools in your VMware product to add the additional disks.
- If you have a Windows NT 4.0 guest with a SCSI virtual disk, you cannot add both an additional SCSI disk and an IDE disk to the configuration.
- If you intend to run a Windows NT virtual machine with IDE virtual disks on a multiprocessor host computer, you might notice slower than expected disk input/output performance. For more information, see Disk Performance in Windows NT Guests on Multiprocessor Hosts in the GSX Server documentation.

Installation Steps

1. Insert the Windows NT 4.0 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Windows NT 4.0.
3. Follow the installation steps as you would for a physical machine.
4. Virtual disks support DMA transfers for better performance.

You can enable the feature after installing Windows NT 4.0. You need the NT Service Pack 3 or 4 CD to enable this option. Once the virtual machine is running Windows NT, insert the SP3 or SP4 CD in the drive, run DMACHECK.EXE from the \SUPPORT\UTILS\I386 folder on the CD and click the Enabled option for the IDE controller/channel that is configured with the virtual disk (typically channel 0 only, unless you have the virtual machine configured with multiple virtual disks).

**NOTE** The DMA option should not be enabled for any IDE channel that has a CD-ROM drive configured for it. Enabling DMA for such a configuration causes an error. If you have a virtual disk and a CD-ROM attached as master and slave to the primary IDE controller (channel 0) and you want to enable DMA, power off the virtual machine and use the Configuration Editor to move the CD-ROM to the secondary IDE controller (channel 1) at IDE 1:0. Then boot the virtual machine with Windows NT, run DMACHECK and enable DMA for channel 0 only.

DMA is always enabled on SCSI virtual disks.

Post Installation Instructions

**Enabling Networking After Installing Windows NT 4.0**

If networking was disabled at the time you installed Windows NT, you can enable it after installing the operating system. Shut down Windows NT and power off the virtual machine. Add the network adapter to the virtual machine's configuration, and then follow the instructions below to install the network driver in the Windows NT guest operating system.

1. Power on the virtual machine.
2. While Windows NT is booting, insert the Windows NT 4.0 CD in the CD-ROM drive.
3 Log on to Windows NT and install the AMD PCNET driver:
   a Open the Network properties page by double-clicking the Network icon in Control Panel. Change to
      the Network Adapters screen by clicking the Adapters tab.
   b Click the Add button and select the AMD PCNET Family Ethernet Adapter from the list.
   c A message pops up prompting you to enter a path for the Windows NT files. Specify the \i386 folder
      on the CD in the path you enter (for example, type D:\i386 if the CD is in drive D) and click
      Continue.
   d Windows NT setup prompts you for the Windows NT files again. Click Continue.
   e Use the default adapter settings; they do not need to be changed. Windows NT setup prompts you
      again for a path to the Windows NT files. Click Continue to finish installing the driver.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base

**NOTE** To view VMware Tools online help in a Windows NT 4.0 guest, Windows NT 4.0 must have Internet
Explorer 4.0 or greater installed.
Windows Me

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows Millennium Edition in a virtual machine using the standard Windows Me CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Me:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows Me:

- The recommended memory size for Windows Me is 64MB. If you use more than 512MB, you might encounter problems. Consult the Microsoft Web site for a workaround. See http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

Installation Steps

1. Insert the Windows Me CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Windows Me.
3. Choose to boot from CD-ROM, and then select the option Start Windows Me Setup from CD-ROM. The setup program runs FDISK and reboots.
4. Once again, choose to boot from CD-ROM, and then select the option Start Windows Me Setup from CD-ROM. The setup program continues installing Windows Me.
5. Follow the Windows Me installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Windows 98

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows 98 in a virtual machine using the standard Windows 98 CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 98:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows 95:

- The recommended memory size for Windows 98 is 64MB. If you use more than 512MB you might encounter problems. Consult the Microsoft Web site for a workaround. See http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

Installation Steps

1. Insert the Windows 98 CD in the CD-ROM drive.

   **NOTE** Some Windows 98 packages require that you boot from a floppy disk. If you have such a package, insert the boot floppy in the floppy disk drive. Follow the on-screen instructions. Be sure to run FDISK and FORMAT when the installer prompts you to do so.

2. Power on the virtual machine to start installing Windows 98.

3. Choose to boot from CD-ROM, and then select the option **Start Windows 98 Setup from CD-ROM**. The setup program runs FDISK and reboots.

4. Once again, choose to boot from CD-ROM, and then select the option **Start Windows 98 Setup from CD-ROM**. The setup program continues installing Windows 98.

5. Follow the Windows 98 installation steps as you would for a physical PC.

Post Installation Instructions

**Enabling Networking After Installing Windows 98**

If networking was disabled at the time you installed Windows 98, you can enable it after the operating system has been installed. To set up networking for a virtual machine, power off the virtual machine and add a network adapter to the configuration. When you power on the virtual machine, Windows 98 automatically detects an AMD PCNET Family Ethernet Adapter (PCI-ISA) and prompts for the Windows 98 CD-ROM to install drivers. The default Ethernet adapter settings should work well and do not need to be changed. Use the Network icon in the Windows 98 Control Panel to view or change network settings. For example, you might want to add the TCP/IP protocol since Windows 98 does not install it by default.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Windows 95

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install Windows 95 in a virtual machine using a standard Windows 95 boot floppy and CD-ROM. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Window95:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Windows 95:

- The recommended memory size for Windows 95 is 64MB. If you use more than 512MB you might encounter problems. Consult the Microsoft Web site for a workaround. See http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

- You must FDISK and FORMAT the virtual hard disk drives before running Windows 95 setup. (Some Windows 95 distributions provide instructions that do not include the steps to FDISK and FORMAT a C: drive.)

- The installation instructions are for the simplest case of one virtual IDE hard drive and one virtual IDE CD-ROM drive. If you have configured the virtual machine with more than one IDE hard drive, you should also FDISK and FORMAT these drives before installing Windows 95. If you have configured the virtual machine with more than one virtual hard drive or more than one virtual CD-ROM, you might need to use device letters that are different from those in the instructions below.

Installation Steps

1. Insert the Windows 95 CD-ROM Setup Boot Disk in floppy drive A: used by your virtual machine and insert the Windows 95 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Windows 95.
3. After the virtual machine boots, if you are presented with a choice of CD-ROM drivers, select the first IDE driver option available (even if your computer has a SCSI CD-ROM drive).
4. Partition the virtual disk.
   A:\> FDISK
   Answer the questions.
   **NOTE**: If you create a primary partition that is smaller than the full size of the virtual disk, be sure the partition is marked active.
5. Reboot Windows 95. If the cursor is not already within the virtual machine window, click in the virtual machine display, and then press Ctrl+Alt+Ins on a Windows host or Ctrl+Alt+Del on a Linux host. If prompted on reboot to select a CD-ROM driver, select the first IDE CD-ROM driver from the list.
6. Format the C: drive.
   A:\> FORMAT C: /S
7. Start the Windows 95 installation.
   A:\> D:\WIN95\SETUP /IS

An intermittent problem can occur during Windows 95 installations in a virtual machine. Shortly after the Windows 95 Setup program is started, Scandisk runs to completion, and when the Windows 95 Setup program should start its graphical user interface, the virtual machine returns to an MS-DOS prompt. VMware recommends you reboot the virtual machine and rerun Windows 95 Setup. You do not need to FDISK or FORMAT the drive again. If this problem occurs reproducibly, please report it to VMware technical support.
If the virtual machine's Ethernet adapter is enabled, you have to manually add an Ethernet driver because Windows 95 does not detect it during the Analyzing Computer phase (even if you selected the **Network Adapter** detection option). Do the following to enable networking:

a  Continue with the Windows 95 installation until you get to the Windows 95 Setup Wizard/Setup Options screen. Change the default setting from **Typical** to **Custom** and click Next to continue.

b  From the Network Configuration screen (which appears after the Analyzing Computer phase), click **Add**, select the **Adapter** component, select **Advanced Micro Devices** from the manufacturer window and **AMD PCNET Family Ethernet Adapter (PCI&ISA)** from the network adapter window.

c  If you need TCP/IP networking, add it from the Network Configuration screen (Windows 95 Setup does not enable TCP/IP by default). If you don’t do this, the first phase of the Windows 95 installation does not copy some of the files it will need later, and the entire installation fails.

Also be sure that the Microsoft NetBEUI protocol is installed. It might not be installed by default.

9  Finish the Windows 95 installation.

10  VMware virtual disks support DMA transfers for better performance. The feature can be enabled after you have installed Windows 95 on a virtual IDE disk. Follow these steps to enable the feature:

a  Right-click **My Computer** and select **Properties**.

b  From the System Properties dialog box, click the **Device Manager** tab.

c  Double-click the **Disk Drives** device category.

d  Double-click the **GENERIC IDE DISK TYPE01** device.

e  Click the **Settings** tab and select the **DMA** check box.

**Post Installation Instructions**

If networking was disabled at the time you installed Windows 95, you can enable it after installing the operating system. Shut down Windows 95 and power off the virtual machine. Add the network adapter to the virtual machine’s configuration, and then follow the instructions below to install the network driver in the Windows 95 guest operating system.

1  Power on the virtual machine.

2  When Windows 95 reboots, it auto-detects an AMD PCNET Family Ethernet Adapter (PCI&ISA) and prompts for the Windows 95 CD-ROM to install drivers. The default Ethernet adapter settings should work fine and do not need to be changed.

3  Double-click the **Network** icon in the Control Panel to view or change network settings. For example, you might want to add the TCP/IP protocol since Windows 95 does not install it by default.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
MS-DOS 6.22 and Windows 3.1x

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

Requirements for installing MS-DOS 6.22 and Windows 3.1.x:

- A new configured virtual machine.
- Full version of the Microsoft MS-DOS 6.22 installation disks.
- Windows 3.1x standard installation disks.
- CD-ROM drivers – by default the \OAKCDROM. sys driver is provided with MS-DOS startup disks. You can also use other drivers that are available to you, for example AOATAPI. SYS, or else you can download drivers from the web. These drivers are typically loaded at system startup by making a series of entries in the C:\CONFIG.SYS and C:\AUTOEXEC.BAT machine files.

MS-DOS 6.22 and Windows 3.1x Installation

You can install MS-DOS 6.22 inside a virtual machine using the Microsoft full-version MS-DOS 6.22 installation disks. If you have the upgrade disks, you must install an earlier version of MS-DOS 6.22 before you upgrade.

NOTE The HIMEM. SYS file is included with MS-DOS and enables upper memory for MSCDEX. EXE.

VMware Workstation, VMware ACE, and GSX Server virtual machines support the networking features found in Windows 3.11 (or Windows for Workgroups). After installation, select the Advanced Micro Devices PCNET Family (NDIS2/NDIS3) Ethernet driver for the networking option.

The following articles provide information for configuring networking in a DOS 6.22 and Win 3.1x environment:

- Create a VMware Workstation Network Boot Disk – http://communities.vmware.com/message/38060

To install MS-DOS 6.22

1. Insert the MS-DOS disk into the disk drive.
2. Power on the virtual machine and begin installing MS-DOS.
3. After the installation is complete, reboot the guest.

The command prompt appears.

To complete the MS-DOS installation

1. Verify that the following files are installed in the root directory of the boot device:
   MSCDEX. EXE, AUTOEXEC. BAT, and CONFIG. SYS file in C:\
2. Copy the \OAKCDROM. SYS CD-ROM driver file to a disk.
3. Insert the disk with the driver file in the disk drive and connect it to the guest from the VM > Settings menu.
4. From the command prompt, copy the contents from drive A to drive C.
   A:\\OAKCDROM. SYS  C:\DOS\
5. Open and edit the MS-DOS AUTOEXEC. BAT file. Add the following line:
   LH C:\DOS\MSCDEX. EXE /D:mscd001 /I:D
6. Save the file and exit.
7 Open and edit the CONFIG.SYS file. Add the following lines:

```plaintext
DEVICE=C:\DOS\HIMEM.SYS
DEVICEHIGH=C:\DOS\oakcdrom.sys /D:mscd001
LAST DRIVE=Z
```

8 Save the file and exit.

9 Restart the MS-DOS 6.22 virtual machine.

As the installation configures the AUTOEXEC.BAT and CONFIG.SYS files, the CD-ROM drive appears in the guest.

To install Windows 3.1x

1 Insert the Windows 3.1x Standard Installation Disks into the disk drive. and connect it to the guest from the VM > Settings menu.

2 Run the SETUP program and follow the prompts to complete the installation.

3 When the installation completes, restart the guest.

**Post Installation Considerations for MS-DOS 6.22 and Windows 3.1x**

After you install MS-DOS 6.22, VMware recommends that you install a CPU idle program within the virtual machine. Most versions of MS-DOS 6.22 do not idle the CPU when they are idle. As a result, when you run MS-DOS 6.22 in a virtual machine, the virtual machine takes up CPU time on the host even when MS-DOS 6.22 is idle. VMware products rely on the guest operating system to use the Halt instruction or advanced power management to unschedule the virtual machine when it is idle.

Run Windows 3.1x in full screen mode to avoid intermittent and erratic mouse behavior.

**VMware Tools**

No VMware Tools package exists for MS-DOS 6.22 or Windows 3.1x guest operating systems. As a result, Windows 3.1x is limited to VGA mode graphics, and you must always use the Ctrl+Alt key combination to release the mouse from a MS-DOS 6.22 or Windows 3.1x virtual machine.
Asianux Server 3.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Asianux Server 3.0 in a virtual machine is to use the standard Asianux distribution CD. Installing Asianux 3.0 via the boot floppy/network method is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Asianux Server 3.0:

- Create and configure a new virtual machine.

### Installation Steps

1. Insert the Asianux Server 3.0 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing Asianux Server 3.0.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. In the Package Group Selection screen, choose **Software Development** and select individual packages. In the Individual Package Selection screen, use the arrow keys to move down to **System Environment/Kernel** and press **Enter**. Be sure that kernel-smp is deselected (no asterisk should appear between the brackets). The SMP kernel is not supported in a virtual machine. You do not need to change any other selections.
5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen, or partition the virtual disk manually if you do not want to use the Asianux defaults.
   
   You might see a warning that begins “The partition table on device `<devicename>` was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.
6. Click **Yes** to partition the drive.
7. If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option **Use bootp/dhcp**. If you prefer, you can also set the networking parameters manually.

This completes basic installation of the Asianux Server 3.0 guest operating system.

### VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Do not start the X server in the guest operating system until you install VMware Tools.
CentOS 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing CentOS 5.0 in a virtual machine is to use the standard CentOS distribution CD. Installing CentOS 5.0 via the boot floppy/network method is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing CentOS 5.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for CentOS 5.0:

- Select Red Hat Enterprise Linux 5 or Red Hat Enterprise Linux 5 64-bit for the guest operating system when creating the virtual machine. CentOS 5 is not listed as an option.
- Configure the virtual machine with a minimum of 512MB of memory. If the virtual machine has less than 512MB of memory, CentOS 5.0 displays an error message as it loads certain VMware drivers.
- Use the LSI Logic SCSI adapter. CentOS 5.0 does not include a driver for the BusLogic SCSI adapter.
- On a Linux host with an XFree86 3.x X server, do not run a screen saver in the guest operating system. Guest screen savers that demand a lot of processing power can cause the X server on the host to freeze.

Installation Steps

1. Insert the CentOS 5.0 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing CentOS 5.0.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Do not select the Virtualization Option during the installation. Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the CentOS defaults.
   
   You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

6. Click Yes to partition the drive.

This completes basic installation of the CentOS 5.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
CentOS 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing CentOS 4.0 in a virtual machine is to use the standard CentOS distribution CD. You can also install CentOS 4.0 with the boot floppy/network method. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing CentOS 4.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for CentOS 4.0:

- Select Red Hat Enterprise Linux 4 or Red Hat Enterprise Linux 4 64-bit for the guest operating system. CentOS 4 is not listed as an option.
- Configure the virtual machine with a minimum of 512MB of memory. If the virtual machine has less than 512MB of memory, CentOS 4.0 displays an error message as it loads certain VMware drivers.
- Select the LSI Logic SCSI adapter. CentOS 4.0 does not include a driver for the BusLogic SCSI adapter.

Installation Steps

1. Insert the CentOS 4.0 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing CentOS 4.0.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Do not select the Virtualization Option during the installation. Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the CentOS defaults.
   You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.
6. Click Yes to partition the drive.

This completes basic installation of the CentOS 4.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Debian 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Debian 5.0 in a virtual machine is to use the standard Debian 5.0 distribution CD.

Fulfill these prerequisites before installing Debian 5.0:
- Create and configure a new virtual machine.

Consider these support and configuration issues for Debian 5.0:
- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Debian 5.0 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Debian 5.0.
3. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt/ Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Debian 5.0 user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** For Debian 5.0, install VMware Tools using the tar installer.
Debian 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Debian 4.0 in a virtual machine is to use the standard Debian 4.0 distribution CD.

Fulfill these prerequisites before installing Debian 4.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Debian 4.0:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

**Installation Steps**

1. Insert the Debian 4.0 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Debian 4.0.
3. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt/Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Debian 4.0 user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** For Debian 4.0, install VMware Tools using the tar installer.
eComStation 1.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing eComStation 1.0 in a virtual machine is to use the standard eComStation 1.0 distribution CD.

Fulfill these prerequisites before installing eComStation 1.0:

■ Create and configure a new virtual machine.

■ When configuring the virtual machine, select eComStation for the Guest Operating System version in the New Virtual Machine Wizard. If this selection is not available, select OS/2 or Other.

Consider these support and configuration issues for eComStation 1.0:

■ If you have access to eComStation 1.2R in the pre-boot menu, you can select the IBM IDE driver instead of the DANIS506 driver. The DANIS506 IDE driver might not function correctly in an eComStation virtual machine.

Installation Steps

1. Insert the eComStation 1.0 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing eComStation 1.0.
3. Follow the installation steps as you would for a physical PC.
4. While installing and after powering on eComStation 1.0, instead of booting the installation disk with the default values, select boot with menu for own values.
5. Page down to the BOOT OPTIONS: Storage page.
6. Use the up arrow key to select IBM1S506/IBMATAPI for the (E)IDE/ATA(PI) controller.
7. Press F10 and Enter to save these options and continue the boot process.

VMware Tools

There is no version of VMware Tools that supports eComStation 1.0.
IBM OS/2 Warp 4.5.2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing IBM OS/2 Warp 4.5.2 in a virtual machine is to use the standard distribution CD.

Fulfill these requirements before you install OS/2 Warp 4.5.2:

- Create and configure a virtual machine.
- Configure OS swap with at least 120MB of space.
- Have both the OS/2 Warp 4.5.2 boot disk CD and the OS/2 Warp 4.5.2 install CD available for install.

Consider these support and configuration issues for IBM OS/2 Warp 4.5.2:

- Additional disks should be less than or equal to 528MB.
- Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The same is true for LSI Logic and IDE.

Installation Steps

1. Insert the OS/2 Warp 4.5.2 boot disk in the CD drive.
2. Power on the virtual machine to start installing IBM OS/2 Warp 4.5.2.
3. Make sure Boot from CDROM Drive is enabled in the BIOS settings.
4. After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.5.2 install CD into the CD drive.
5. Press the F3 key to use the command line interface to partition the hard drive.
   Alternatively, press Enter to select the GUI mode.
6. Partition the hard disk drive using the FDISK utility. Create an appropriate start volume on which to install the guest, and save the FDISK settings.
7. Reinsert the OS/2 Warp 4.5.2 boot disk in the CD drive and reboot the guest.
8. After the initial startup completes, insert the OS/2 Warp 4.5.2 install CD in the CD drive.
   The start volume is displayed on the screen.
9. Select an appropriate volume to install the guest.
10. Format the filesystem with File Allocation Table (FAT) File System or High Performance File System (HPFS).
11. Continue the installation by selecting components, utilities, and other resources.
12. After completing the installation, reboot the guest.

Create Boot Disks

Create boot disks from the 32-bit OS/2 Warp 4.5.2 install CD, using the CDINST utility on a running OS/2 Warp 4.5.2 guest.

1. Power on a system in which 32-bit OS/2 Warp 4.5.2 is installed.
2. Insert the 32-bit OS/2 Warp 4.5.2 install CD into the CD drive.
3. Double-click on the CDINST utility that is located in the root directory.
4. Insert blank disks, one by one respectively.
   This creates bootable disks for 32-bit OS/2 Warp 4.5.2.
VMware Tools

There is no version of VMware Tools that supports IBM OS/2 Warp 4.5.2.
IBM OS/2 Warp 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing IBM OS/2 Warp 4.0 in a virtual machine is to use the standard distribution CD.

Fulfill these requirements before you install OS/2 Warp 4.0:

- Create and configure a new virtual machine.
- Create a minimum of 120 MB for OS swap space.
- Have both the OS/2 Warp 4.0 boot disk CD and the OS/2 Warp 4.0 install CD available for install.

Consider these support and configuration issues for IBM OS/2 Warp 4.0:

- Additional disks size should be less than or equal to 528MB.
- Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The same is true for LSI Logic and IDE.

**Installation Steps**

1. Insert the first OS/2 Warp 4.0 installer disk in the disk drive.
2. Make sure *Boot from Removable Devices—Legacy Floppy Drives* is enabled from the BIOS settings.
3. Insert the second and third installer disks when requested.
4. After installing the required drivers from the third disk, insert the OS/2 Warp 4.0 install CD into the CD drive.
5. After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.0 install CD into the CD drive.
6. Press the F3 key to use the command line interface to partition the hard drive.
   Alternatively, press Enter to select the GUI mode.
7. Partition the hard disk drive using the FDISK utility. Create an appropriate start volume on which to install the guest, and save the FDISK settings.
8. Re-insert the first OS/2 Warp 4.0 installer disk in the CD drive and reboot the guest.
9. Re-insert the second and third installer disks during the initial startup.
10. After the initial startup completes, insert the OS/2 Warp 4.0 install CD in the CD drive.
    The start volume is displayed on the screen.
11. Select an appropriate volume to install the guest.
12. Format the filesystem with File Allocation Table (FAT) File System or High Performance File System (HPFS).
13. Continue the installation by selecting components, utilities, and other resources.
14. After completing the installation, reboot the guest.

**Create Boot Disks**

Create boot disks from the 32-bit OS/2 Warp 4.0 install CD, using the CDINST utility on a running OS/2 Warp 4.0 guest.

1. Power on a system in which 32-bit OS/2 Warp 4.0 is installed.
2. Insert the 32-bit OS/2 Warp 4.0 install CD into the CD drive.
3. Double-click on the CDINST utility that is located in the root directory.
4 Insert three blank disks, one by one, respectively.
   This creates bootable disks for 32-bit OS/2 Warp 4.0.

**VMware Tools**

There is no version of VMware Tools that supports IBM OS/2 Warp 4.0
Mac OS X Server 10.5

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

Fulfill these requirements before you install Mac OS X Server 10.5:

- Before creating a virtual machine, obtain the operating system and any necessary product keys for installation in that virtual machine.
- VMware Fusion does not come with any operating systems to install in the virtual machines you create.
- Create and configure a virtual machine.

Consider these support issues for Mac OS X Server 10.5:

- Use the Mac OS X disk utility to increase the size of the disk partition after installing the operating system (If you increase the size of the disk partition when creating the virtual machine, you will not gain access to additional space.)

**Installation Steps**

1. From the Virtual Machine Library window, click the **New** button, or choose **File > New**.
   The New Virtual Machine Assistant starts.

2. In the Introduction panel, what you do depends on whether you are using an operating system installation CD, an operating system installation disk image file (ISO), or an existing virtual disk:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system installation disk</td>
<td>Insert the disk into your Mac. VMware Fusion detects it and asks for confirmation that it is the operating system you want to install. If it is the correct OS, ensure that <strong>Install this operating system</strong> is selected and click <strong>Continue</strong>. If it is not the correct OS, select <strong>Install a different operating system</strong> and click <strong>Continue</strong>.</td>
</tr>
<tr>
<td>Operating system installation disk image file</td>
<td>Click <strong>Continue without disk</strong>.</td>
</tr>
<tr>
<td>Existing virtual disk</td>
<td>Click <strong>Continue without disk</strong>.</td>
</tr>
</tbody>
</table>

3. In the Installation Media panel, choose one of four options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use operating system installation disk</td>
<td>Use the pop-up menu to choose an operating system installation disk.</td>
</tr>
<tr>
<td>Use operating system installation disk image file</td>
<td>Use the pop-up menu to browse for the .iso file for the operating system. Click <strong>Choose to identify the file</strong>.</td>
</tr>
<tr>
<td>Use an existing virtual disk</td>
<td>Select this option to use an existing virtual disk. Use the pop-up menu to browse for the existing virtual disk (.vmdk) file. Click <strong>Choose to identify the file</strong>.</td>
</tr>
<tr>
<td>Create a custom virtual machine</td>
<td>Select this option if you are creating a custom virtual machine. For instance, you would use this if you are installing an older operating system off of floppy images.</td>
</tr>
</tbody>
</table>

4. Click **Continue** to go to the Operating System panel.

5. In the Operating System panel, ensure that the operating system and version for the new virtual machine are correct, or select the correct ones from the pop-up menus. Click **Continue**.
6 In the Finish panel:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create the virtual machine according to the specifications listed in the Finish panel</td>
<td>Click Finish. Once you indicate the folder in which you want to save the virtual machine (default is your &lt;user&gt;/Documents/Virtual Machines folder), clicking Save launches the virtual machine.</td>
</tr>
<tr>
<td>To change disk size or other standard settings of the virtual machine</td>
<td>Click Customize Settings. Save the new virtual machine. Once you save the new virtual machine, Fusion displays the Settings window, with which you can make changes to the virtual machine's disk size, processor usage, removable devices, and so on. When you close the Settings window, VMware Fusion launches the virtual machine.</td>
</tr>
</tbody>
</table>

This completes basic set up of the virtual machine.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Mandriva Corporate 4

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandriva Corporate 4 Desktop or Server in a virtual machine is to use the standard Mandriva Linux distribution CD. You can also install Mandriva Corporate 4 with a boot floppy/network method is supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Corporate 4:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Corporate 4:

- During the Mandriva Corporate 4 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandriva Corporate 4.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

- On a Linux host with an XFree86 3.x X server, it is best not to run a screen saver in the guest operating system. Guest screen savers that demand a lot of processing power can cause the X server on the host to freeze.

Installation Steps

1. Insert the Mandriva Corporate 4 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Mandriva Corporate 4.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter **text** for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux automatically allocate the space. Select **Use free space**.
6. When you reach the Summary screen, configure the graphical interface.
   - Select **Graphical Interface**, and then click **Do**. Make the following selections:
     - The resolution and refresh rate you want your guest to use
     - VMware virtual video card
     - **No** when asked if you want to install updates to the packages
     - **No** when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Corporate 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
Mandriva Linux 2009

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandriva Linux 2009 in a virtual machine is to use the standard Mandriva Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandriva Linux 2009 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2009:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2009:

- During the Mandriva Linux 2009 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandriva Linux 2009.
- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Mandriva Linux 2009 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Mandriva Linux 2009.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux automatically allocate the space. Select Use free space.
6. When you reach the Summary screen, configure the graphical interface.
   Select Graphical Interface, and then click Do. Make the following selections:
   - The resolution and refresh rate you want your guest to use
   - VMware virtual video card
   - No when asked if you want to install updates to the packages
   - No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2009 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Mandriva Linux 2008

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandriva Linux 2008 in a virtual machine is to use the standard Mandriva Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandriva Linux 2008 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2008:
- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2008:
- During the Mandriva Linux 2008 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandriva Linux 2008.
- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Mandriva Linux 2008 CD in the CD-ROM drive.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux automatically allocate the space. Select Use free space.
6. When you reach the Summary screen, configure the graphical interface.
   - Select Graphical Interface, and then click Do. Make the following selections:
     - The resolution and refresh rate you want your guest to use
     - VMware virtual video card
     - No when asked if you want to install updates to the packages
     - No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2008 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Mandriva Linux 2007

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandriva Linux 2007 in a virtual machine is to use the standard Mandriva Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandriva Linux 2007 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2007:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2007:

- During the Mandriva Linux 2007 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandriva Linux 2007.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Mandriva Linux 2007 CD in the CD-ROM drive.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux automatically allocate the space. Select Use free space.
6. When you reach the Summary screen, configure the graphical interface.

   Select Graphical Interface, and then click Do. Make the following selections:
   - The resolution and refresh rate you want your guest to use
   - VMware virtual video card
   - No when asked if you want to install updates to the packages
   - No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2007 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Mandriva Linux 2006

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandriva Linux 2006 in a virtual machine is to use the standard Mandriva Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandriva Linux 2006 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2006:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2006:

- During the Mandriva Linux 2006 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandriva Linux 2006.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Mandriva Linux 2006 CD in the CD-ROM drive.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux automatically allocate the space. Select Use free space.
6. When you reach the Summary screen, configure the graphical interface.
   Select Graphical Interface, and then click Do. Make the following selections:
   - The resolution and refresh rate you want your guest to use
   - VMware virtual video card
   - No when asked if you want to install updates to the packages
   - No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2006 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Mandrake Linux 10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandrake Linux 10 in a virtual machine is to use the standard Mandrake Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandrake Linux 10 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandrake Linux 10:

- During the Mandrake Linux 10 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandrake Linux 10.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Mandrake Linux 10 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Mandrake Linux 10.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the text mode installer. At the opening screen, press F1 for options, and then enter **text** for text mode.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux automatically allocate the space. Select **Use free space**.
6. When you reach the Summary screen, configure the graphical interface.
   Select **Graphical Interface**, and then click **Do**. Make the following selections:
   - The resolution and refresh rate you want your guest to use
   - VMware virtual video card
   - **No** when asked if you want to install updates to the packages
   - **No** when asked if you want to start X when you reboot

This completes basic installation of the Mandrake Linux 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
Mandrake Linux 9

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandrake Linux 9 in a virtual machine is to use the standard Mandrake Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandrake Linux 9.2 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandrake Linux 9:

- During the Mandrake Linux 9 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandrake Linux 9.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps for Mandrake Linux 9.2

1. Insert the Mandrake Linux 9.2 CD in the CD-ROM drive.
2. Power on the virtual machine.
3. Install this operating system as you would on a physical machine.
   The following steps include only those steps that are specific to installing this guest on a VMware virtual machine.
4. Click in the opening screen and press F1 to install using text mode.
5. At the command line, type text and press Enter.
6. In the DrakX Partitioning wizard found the following solutions screen, select Use free space and select Next.
   Unless you have special disk requirements, let Mandrake Linux allocate the space.
7. When you reach the Package Group Selection screen, select the type of computer on which you installed your VMware product.
   If you installed your VMware product on a laptop computer, make the following selections:
   a. Click Advanced.
   b. Select Individual package selection and select Next.
   c. Scroll to numlock and deselect the asterisk and select Next.
      If you do not disable numlock when you install the guest on a laptop, the number lock is always active in the guest. You cannot disable it by pressing the Num Lock key.
8. When you reach the Summary screen, select Graphical interface and select Do.
9. Make the following selections for the graphical interface:
   - A monitor for the guest
   - VMware virtual video card
   - XFree 4.3
   - The resolution and refresh rate for the guest
- No to not test the configuration
- No to not start X when you reboot

When you complete the graphical interface selections, the Summary screen reappears.

10 In the Summary screen, select Next.

11 Select No to not install updates to the packages.

12 Select Reboot to complete the basic installation of the Mandrake Linux 9.2 guest operating system.

This completes basic installation of the Mandrake Linux 9.2 guest operating system.

**Installation Steps for Mandrake Linux 9.1 and 9.0**

1 Insert the Mandrake Linux 9.1 or 9.0 CD in the CD-ROM drive.

2 Power on the virtual machine to start installing Mandrake Linux 9.1 or 9.0.

3 Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4 Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

5 Use the Expert installer.

6 In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux automatically allocate the space. Click Use free space.

7 **VMware GSX Server:** When selecting a boot loader, use LILO with text menu. Do not use the graphical version of LILO. It causes the virtual machine to hang.

8 Do not create a custom boot disk when prompted.

9 Near the end of the installation, after files have been copied, you reach the monitor setup screen. Select the resolution and refresh rate you want your guest to use. Select VMware virtual video card.

10 You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.1. This driver recognizes the VMware SVGA driver.

11 When the installer asks if you want to test the configuration, answer No.

12 When the installer asks whether to start X when you reboot, answer No.

13 When the installer asks if you want to install updates to the packages, answer No.

This completes basic installation of the Mandrake Linux 9.1 or 9.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

With a Mandrake Linux 9 guest, you should install VMware Tools from the Linux console. Do not start X until you have installed VMware Tools.

**NOTE** As you are installing and configuring VMware Tools, the configuration program asks for the location of lspci. When that prompt appears, enter the following path: /usr/bin/lspcidrake
Mandrake Linux 8

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Mandrake Linux 8 in a virtual machine is to use the standard Mandrake Linux distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Mandrake Linux 8 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 8:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Mandrake Linux 8:

- During the Mandrake Linux 8 installation, you are offered a choice of XFree86 X servers. You can choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Mandrake Linux 8.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps for Mandrake Linux 8.2

1. Insert the Mandrake Linux 8.2 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Mandrake Linux 8.2.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the Expert installer.
5. In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux auto-allocate the space.
6. When selecting a boot loader, use LILO with text menu. Do not use the graphical version of LILO. It causes the virtual machine to hang.
7. Do not create a custom boot disk when prompted.
8. You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.0. This driver recognizes the VMware SVGA driver.
9. Near the end of the installation, after files have been copied, you reach the monitor setup screen. Choose the resolution and refresh rate you want your guest to use.
10. When the installer asks if you want to test the configuration, answer No.
11. When the installer asks if you want to install system updates, answer No.
12. When the installer asks whether to start X when you reboot, answer No.

This completes basic installation of the Mandrake Linux 8.2 guest operating system.

Installation Steps for Mandrake Linux 8.1 and 8.0

1. Insert the Mandrake Linux 8.1 or 8.0 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Mandrake Linux 8.1 or 8.0.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Use the Expert installer.
5 In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux auto-allocate the space.

6 When selecting a boot loader, use LILO with text menu. Do not use the graphical version of LILO. It causes the virtual machine to hang.

7 On the Select a Graphic Card screen, choose Other->Generic VGA compatible.

8 Near the end of the installation, after files have been copied, you reach the monitor setup screen. Choose Super VGA, 800x600 @ 56 Hz.

9 When the installer asks whether to start X when you reboot, answer No.

This completes basic installation of the Mandrake Linux 8.1 or 8.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** With a Mandrake Linux 8 guest, you should install VMware Tools from the Linux console. Do not start X until you have installed VMware Tools and set up a symbolic link to the XFree86 configuration file.

**To set up a symbolic link to XFree86**

1 Log on as root (su –), and then set up a symbolic link to the correct XFree86 configuration file.
   
   ```bash
   cd /etc
   ln -s /etc/X11/XF86Config.vm XF86Config
   ```

2 Use the startx command to start your X server.

**NOTE** As you are installing and configuring VMware Tools, the configuration program asks for the location of lspci. When that prompt appears, enter the following path: /usr/bin/lspcidrake
Novell Linux Desktop 9

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Novell Linux Desktop 9 in a virtual machine is to use the standard Novell Linux Desktop distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing Novell Linux Desktop 9 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Novell Linux Desktop 9:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Novell Linux Desktop 9:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Novell Linux Desktop 9 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Novell Linux Desktop 9.
3. Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. During final configuration, after all packages are installed, do not perform the Internet connection test.
5. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Novell Linux Desktop 9 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Oracle Enterprise Linux 5

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Oracle Enterprise Linux 5 in a virtual machine is to use the standard distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Oracle Enterprise Linux 5 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Oracle Enterprise Linux 5:

- Create and configure a new virtual machine.
- For ESX, select Red Hat Enterprise Linux 5 32-bit or Red Hat Enterprise Linux 5 64-bit for the guest operating system. Oracle Enterprise Linux 5 is not listed as an option.

Consider these support and configuration issues for Oracle Enterprise Linux 5:

- When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Oracle Enterprise Linux 5 does not include a driver for the BusLogic SCSI adapter.
- Be sure the virtual machine is configured with at least 512MB of memory. If the virtual machine has less than 512MB of memory, Oracle Enterprise Linux 5 presents an error message as it loads certain VMware drivers.

Installation Steps

1. Insert the Oracle Enterprise Linux 5 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing Oracle Enterprise Linux 5.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Do not select Virtualization Option during the installation. Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the defaults.

You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

6. Click Yes to partition the drive.

This completes basic installation of the Oracle Enterprise Linux 5 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Oracle Enterprise Linux 4

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Oracle Enterprise Linux 4 in a virtual machine is to use the standard distribution CD. The notes below describe an installation using the standard distribution CD. Installing Oracle Enterprise Linux 4 by the boot floppy/network method is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Oracle Enterprise Linux 4:

- Create and configure a new virtual machine.
- For ESX, select Red Hat Enterprise Linux 4 32-bit or Red Hat Enterprise Linux 4 64-bit for the guest operating system. Oracle Enterprise Linux 4 is not listed as an option.

Consider these support and configuration issues for Oracle Enterprise Linux 4:

- When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Oracle Enterprise Linux 4 does not include a driver for the BusLogic SCSI adapter.
- Be sure the virtual machine is configured with at least 512MB of memory. If the virtual machine has less than 512MB of memory, Oracle Enterprise Linux 4 presents an error message as it loads certain VMware drivers.

Installation Steps

1. Insert the Oracle Enterprise Linux 4 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing Oracle Enterprise Linux 4.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Do not select Virtualization Option during the installation. Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the defaults.
   You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.
6. Click Yes to partition the drive.

This completes basic installation of the Oracle Enterprise Linux 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Enterprise Linux 5

This section contains product support, installation instructions, and known issues for the Red Hat Enterprise Linux 5 operating system.

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 5 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Enterprise Linux 5 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 5:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 5:

- Be sure the virtual machine is configured with at least 512MB of memory. If the virtual machine has less than 512MB of memory, Red Hat Enterprise Linux 5 presents an error message as it loads certain VMware drivers.
- When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Red Hat Enterprise Linux 5 does not include a driver for the BusLogic SCSI adapter. Before installing the operating system, be sure that you have already created and configured a new virtual machine.

Installation Steps

1. Insert the Red Hat Enterprise Linux 5 CD-ROM in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Enterprise Linux 5.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. Do not select Virtualization Option during the installation. Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.

5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.

   You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

6. Click Yes to partition the drive.

This completes basic installation of the Red Hat Enterprise Linux 5 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Enterprise Linux 4

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 4 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Enterprise Linux 4 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 4:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 4:

- **VMware Workstation, VMware ACE, VMware GSX Server**: When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Red Hat Enterprise Linux 4 does not include a driver for the BusLogic SCSI adapter.

- Be sure the virtual machine is configured with at least 256MB of memory. If the virtual machine has less than 256MB of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware drivers.

- The Red Hat Enterprise Linux 4 hugemem kernel is not supported. See knowledge base article 8964517 at http://kb.vmware.com/kb/8964517.

- See knowledgebase article 1018631 at http://kb.vmware.com/kb/1018631 for information about a kernel panic error that occurs when you install Red Hat Enterprise Linux 4.0, 4.1, or 4.2 on an AMD NPT processor.

- **SCSI adapter support**
  - Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support only the BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5.
  - Red Hat Enterprise Linux 4, Update 6 and Update 7: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support both the LSI Logic and BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 6 and Update 7.
  - VMware provides a separate driver to support the BusLogic SCSI adapter. For instructions on downloading and installing the BusLogic driver, see www.vmware.com/download/esx/drivers_tools.html.

### Installation Steps

**NOTE**  Pay particular attention to the notes in Step 4 about how to avoid installing an inappropriate kernel.

1. Insert the Red Hat Enterprise Linux 4 CD-ROM in the CD-ROM drive.
3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. **VMware GSX Server**: In the Package Group Selection screen, choose **Software Development** and select individual packages. In the Individual Package Selection screen, use the arrow keys to move down to **System Environment/Kernel** and press **Enter**. Be sure that kernel-smp is deselected (no asterisk should appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do not need to change any other selections.

5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.
You might see a warning that begins “The partition table on device <devicename> was unreadable. To create new partitions it must be initialized, causing the loss of ALL DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

Click Yes to partition the drive.

VMware GSX Server: If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.

VMware ESX Server: If you are using the vlance network adapter in your virtual machine and your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually. If you are using the vmxnet network adapter in your virtual machine, use the network configuration tools in Red Hat Enterprise Linux 4 to configure your network connection after you finish installing the guest operating system.

This completes basic installation of the Red Hat Enterprise Linux 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Enterprise Linux 3

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 3 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Enterprise Linux 3 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 3:

- Create and configure a new virtual machine.
- Consider these support and configuration issues for Red Hat Enterprise Linux 3:
  - The Red Hat Enterprise Linux 3 hugemem kernel is not supported. See knowledge base article 8964517 at http://kb.vmware.com/kb/8964517.
  - Be sure the virtual machine is configured with at least 256MB of memory. If the virtual machine has less than 256MB of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware drivers.
  - With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

**NOTE** Pay particular attention to the notes in Step 6 about how to avoid installing an inappropriate kernel.

1. Insert the Red Hat Enterprise Linux 3 CD-ROM in the CD-ROM drive.
2. Power on the virtual machine to start installing Red Hat Enterprise Linux 3.
   
   You must install Red Hat Enterprise Linux 3 using the text mode installer, which you can choose when you first boot the installer. At the Red Hat Enterprise Linux 3 CD boot prompt, you are offered a number of choices, including the following:
   
   To install or upgrade Red Hat Linux ... in graphical mode ...
   
   To install or upgrade ... in text mode, type: text <ENTER>...
   
   ... Use the function keys listed below ...

   To choose the text mode installer, type **text** and press Enter.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.
4. Choose the language and keyboard, and then in the Installation Type screen, choose either **Advanced Server** or **Custom** for the installation type.
5. In the Mouse Selection screen, choose **Generic – 3 Button Mouse (PS/2)** and select the **Emulate 3 Buttons** option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose **Generic Wheel Mouse (PS/2)**.
6. **VMware GSX Server only:** In the Package Group Selection screen, choose **Software Development** and select individual packages. In the Individual Package Selection screen, use the arrow keys to move down to **System Environment/Kernel** and press **Enter**. Be sure that kernel-smp is deselected (no asterisk should appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do not need to change any other selections.
7. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.
8. You might see a warning that says:
The partition table on device sda was unreadable. To create new partitions, it must be initialized, causing the loss of ALL DATA on the drive. Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select the Yes button and press Enter. Also note that sda appears in the message as the device name if the virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device name instead.

VMware GSX Server: If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.

VMware ESX Server, VMware VirtualCenter, or vCenter Server: If you are using the vlance network adapter in your virtual machine and your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually. If you are using the vmxnet network adapter in your virtual machine, use the network configuration tools in Red Hat Enterprise Linux 3 to configure your network connection after you finish installing the guest operating system.

This completes basic installation of the Red Hat Enterprise Linux 3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Enterprise Linux 2.1

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 2.1 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Enterprise Linux 2.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 2.1:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 2.1:

- **Red Hat Enterprise Linux 2.1 WS on VMware ESX Server:** When you install Red Hat Enterprise Linux 2.1 WS in a virtual machine on an ESX Server, use Update 6 or higher. This eliminates conflicts with the network and SCSI adapters and installation problems on a Red Hat Enterprise Linux 2.1 WS guest operating system.

- If you do not install Update 6 or higher, use one of the following configurations for the network and SCSI adapters:
  - vlance network adapter—Use an LSI Logic SCSI adapter.
  - vmxnet network adapter—Use an LSI Logic SCSI adapter or BusLogic adapter.

- You should not run the X server that is installed when you set up Red Hat Enterprise Linux 2.1. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Red Hat Enterprise Linux 2.1.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

**Installation Steps**

**NOTE** Unless you are running a multiprocessor virtual machine under VMware ESX Server, pay particular attention to the notes in Step 6 about how to avoid installing an inappropriate kernel.

1. Insert the Red Hat Enterprise Linux 2.1 CD-ROM in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Enterprise Linux 2.1.

   You must install Red Hat Enterprise Linux 2.1 using the text mode installer, which you can choose when you first boot the installer. At the Red Hat Enterprise Linux 2.1 CD boot prompt, you are offered a number of choices, including the following:

   To install or upgrade Red Hat Linux ... in graphical mode ... 
   To install or upgrade ... in text mode, type: text <ENTER>...

   Use the function keys listed below ...

   To choose the text mode installer, type **text** and press Enter.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. Choose the language and keyboard, and then in the Installation Type screen, choose either **Advanced Server** or **Custom** for the installation type.

5. In the Mouse Selection screen, choose **Generic – 3 Button Mouse (PS/2)** and select the **Emulate 3 Buttons** option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose **Generic Wheel Mouse (PS/2)**.
6 **VMware GSX Server only:** In the Package Group Selection screen, choose **Software Development** and Select individual packages. In the Individual Package Selection screen, use the arrow keys to move down to **System Environment/Kernel** and press **Enter**. Be sure that kernel-smp is deselected (no asterisk should appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do not need to change any other selections.

**VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine without virtual SMP:** In the Individual Package Selection screen, use the arrow keys to move down to **System Environment/Kernel** and press **Enter**. Be sure that the following kernels are deselected (no asterisk should appear between the brackets):

- kernel-enterprise
- kernel-smp
- kernel-summit

**VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine with virtual SMP:** In the Individual Package Selection screen, use the arrow keys to move down to System Environment/Kernel and press **Enter**.

- If you are installing a multiprocessor virtual machine, be sure kernel-smp is selected.
- If you are installing a uniprocessor virtual machine, be sure the following kernels are deselected: kernel-enterprise, kernel-smp and kernel-summit.

For additional information on using uniprocessor and multiprocessor kernels with a Red Hat Enterprise Linux 2.1 virtual machine under VMware ESX Server, see the release notes at [www.vmware.com/support/esx21/doc/releasenotes_esx213.html](http://www.vmware.com/support/esx21/doc/releasenotes_esx213.html).

7 Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.

8 You might see a warning that says:

The partition table on device sda was unreadable. To create new partitions, it must be initialized, causing the loss of ALL DATA on the drive.

Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select the **Yes** button and press **Enter**. Also note that sda appears in the message as the device name if the virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device name instead.

9 If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option **Use bootp/dhcp**. If you prefer, you can also set the networking parameters manually.

10 In the Video Card Configuration screen, choose **Generic SVGA**.

This completes basic installation of the Red Hat Enterprise Linux 2.1 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Linux 9.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Linux 9.0 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Linux 9.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 9.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 9.0:

- You should not run the X server that is installed when you set up Red Hat Linux 9.0. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Red Hat Linux 9.0.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Red Hat Linux 9.0 CD-ROM in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Linux 9.0.

   You must install Red Hat Linux 9.0 using the text mode installer, which you can choose when you first boot the installer. At the Red Hat Linux 9.0 CD boot prompt, you are offered the following choices:

   To install or upgrade Red Hat Linux ... in graphical mode ...
   To install or upgrade ... in text mode, type: linux text <ENTER>.
   Use the function keys listed below ...

   To choose the text mode installer, type Linux text and press Enter.

   **NOTE** If you attempt to use the graphical installer, it fails and launches the text mode installer.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. Choose the language and keyboard.

5. In the Mouse Selection screen, choose **Generic – 3 Button Mouse (PS/2)** and select the **Emulate 3 Buttons** option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose **Generic Wheel Mouse (PS/2)**.

6. In the Installation Type screen, choose either **Server** or **Workstation** for the installation type.

7. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.

8. You might see a warning that says:

   **Bad partition table. The partition table on device sda is corrupted. To create new partitions, it must be initialized, causing the loss of ALL DATA on the drive.**

   This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select the **Initialize** button and press Enter. Also note that sda appears in the message as the device name if the virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device name instead.
9  If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.

10  In the Video Card Configuration screen, choose Skip X Configuration.

This completes basic installation of the Red Hat Linux 9.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Do not start the X server in the guest operating system until you install VMware Tools.

**NOTE**  When you are installing VMware Tools, the configuration program asks you to specify a resolution for the guest operating system’s display. Set the resolution to 1152 x 864 or lower. If you set a higher resolution, the guest operating system instead switches to a default resolution of 800 x 600.
Red Hat Linux 8.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Linux 8.0 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Linux 8.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 8.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 8.0:

- You should not run the X server that is installed when you set up Red Hat Linux 8.0. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Red Hat Linux 8.0.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Red Hat Linux 8.0 CD-ROM in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Linux 8.0.

   You must install Red Hat Linux 8.0 using the text mode installer, which you can choose when you first boot the installer. At the Red Hat Linux 8.0 CD boot prompt, you are offered the following choices:

   To install or upgrade Red Hat Linux ... in graphical mode ...
   To install or upgrade ... in text mode, type: linux text <ENTER>.
   Use the function keys listed below ...

   To choose the text mode installer, type Linux text and press Enter.

   **NOTE**  If you attempt to use the graphical installer, it fails and launches the text mode installer.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. Choose the language and keyboard, and then in the Installation Type screen, choose either **Server** or **Workstation** for the installation type.

5. In the Mouse Selection screen, choose **Generic – 3 Button Mouse (PS/2)** and select the **Emulate 3 Buttons** option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose **Generic Wheel Mouse (PS/2)**.

6. You might see a warning that says:

   Bad partition table. The partition table on device sda is corrupted. To create new partitions, it must be initialized, causing the loss of ALL DATA on the drive.

   This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select the **Initialize** button and press **Enter**. Also note that sda appears in the message as the device name if the virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hdd appears in the message as the device name instead.

7. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the virtual disk manually if you do not want to use the Red Hat defaults.
8 If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.

9 In the Video Card Configuration screen, choose Skip X Configuration.

This completes basic installation of the Red Hat Linux 8.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Do not start the X server in the guest operating system until you install VMware Tools.
Red Hat Linux 7

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Linux 7 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Linux 7 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 7:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 7:

- You should not run the X server that is installed when you set up Red Hat Linux 7. Instead, to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools package immediately after installing Red Hat Linux 7.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Red Hat Linux 7 CD-ROM in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Linux 7.

   You must install Red Hat Linux 7 using the text mode installer, which you can choose when you first boot the installer. At the Red Hat Linux 7 CD boot prompt, you are offered the following choices:

   To install or upgrade a system ... in graphical mode ...
   To install or upgrade a system ... in text mode, type: text <ENTER>.
   To enable expert mode, ...
   Use the function keys listed below ...

   To choose the text mode installer, type text followed by Enter.

3. Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in the following steps.

4. Choose the language and keyboard, and then in the Installation Type screen, choose either Server or Workstation for the installation type.

   The following warning might appear:

   Bad partition table. The partition table on device sda is corrupted. To create new partitions, it must be initialized, causing the loss of ALL DATA on the drive.

   This does not mean that anything is wrong with the hard drive on your physical computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Click the Initialize button and press Enter. Also note that sda appears in the message as the device name if the virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device name instead.

5. Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen.

6. If your computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.

7. In the Mouse Selection screen, choose Generic – 3 Button Mouse (PS/2) and select the option Emulate 3 Buttons for three-button mouse support in the virtual machine.

8. In the Video Card Selection screen, choose the default selection.
9 During the configuration of the X server, select the defaults and proceed through this section as quickly as possible, as this X server is replaced by an X server specific to your guest operating system when you install VMware Tools in this virtual machine.

10 Continue to the Starting X screen and click **Skip** to skip testing the configuration.

This completes basic installation of the Red Hat Linux 7 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Do not start X until you have installed VMware Tools.
Red Hat Linux 6.2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Red Hat Linux 6.2 in a virtual machine is to use the standard Red Hat distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Red Hat Linux 6.2 via the boot floppy/network method is supported as well.

Fulfill these requirements before you install Red Hat Linux 6.2:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 6.2:

- During the Red Hat Linux 6.x installation, a standard VGA16 X server (without support for the VMware X server) is installed. To run an accelerated SVGA X server inside the virtual machine, install the VMware Tools package immediately after installing Red Hat Linux 6.x.

- Due to VGA performance issues installing Red Hat 6.2 with the graphics mode installer, we highly recommend you install the operating system with the text mode installer. At the Red Hat 6.0.1 or 6.2 CD boot prompt, you are offered the following choices:

  To install or upgrade a system ... in graphical mode ...
  To install or upgrade a system ... in text mode, type: text <ENTER>.
  To enable expert mode, ...  
  Use the function keys listed below ...

  Choose the text mode installer by typing text followed by Enter.

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

**CAUTION** Red Hat Linux 6.2 runs on Intel core processors. However, it does not run on Xeon processors that are branded Xeon, with no qualifier, or Xeon-MP (Pentium III Xeon processors are OK).

### Installation Steps

1. Insert the Red Hat Linux 6.2 installation CD in the CD-ROM drive.

2. Power on the virtual machine to start installing Red Hat Linux 6.2.

   We recommend you install the operating system with the text mode installer. At the Red Hat 6.2 CD boot prompt, you are offered the following choices:

   To install or upgrade a system ... in graphical mode ...
   To install or upgrade a system ... in text mode, type: text <ENTER>.
   To enable expert mode, ...  
   Use the function keys listed below ...

   Choose the text mode installer by typing text followed by Enter.

3. Follow the installation steps as you would for a physical machine.

   **NOTE** If the virtual machine’s Ethernet adapter has been enabled, the installation program auto-detects and loads the AMD PC/Net 32 driver (no command line parameter is necessary to load the driver).

   **NOTE** The text mode installer in Red Hat Linux 6.2 presents a Hostname Configuration screen. If you are installing this guest with DHCP in a virtual machine with host-only networking, do not specify a host name. Just respond OK and continue. (Specifying a host name will cause an installer error later.) At the next screen—Network Configuration—respond OK to use the default: Use bootp/dhcp.

4. During the Linux installation, select the standard VGA16 X server.

5. In the Choose a Card screen, select the **Generic VGA compatible/Generic VGA** card from the list.
6 In the Monitor Setup screen, select **Generic Monitor** from the list.

7 Select the **Probe** button from the Screen Configuration dialog box.

8 Select **OK** from the Starting X dialog box. After Linux is installed, the generic X server is replaced with the accelerated X server included in the VMware Tools package when you install VMware Tools.

9 Finish installing Red Hat Linux 6.2 as you would on a physical machine.

   At this point Red Hat 6.2 boots and a login screen appears.

This completes basic installation of the Red Hat Linux 7.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
Sun Java Desktop System 2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Sun Java Desktop System 2 in a virtual machine is to use the standard Sun Java Desktop System distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing Sun Java Desktop System 2 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Sun Java Desktop System 2:

- Create and configure a new virtual machine.

**Installation Steps**

1. Insert the Sun Java Desktop System 2 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Sun Java Desktop System 2.
3. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Sun Java Desktop System 2 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
SCD OpenServer 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install SCO OpenServer 5.0 in a virtual machine using the standard distribution CDs, via the boot floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SCO OpenServer 5.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SCO OpenServer 5.0:

- Virtual disk recommendations
  - Minimum size – 1.5GiB for the SCO OpenServer 5.0 root disk.
  - biosgeom bootstrap – Required for SCSI drives between 1 and 64GiB. (Not harmful to other drive sizes.)
  - IDE virtual disks – SCO BTLD (wd boot-time loadable driver) for improved performance and reliability.
  - Special considerations for drive sizes:
    - OpenServer 5.0.7 – wd BTLD is required for IDE disks larger than 128GiB (137GB).
    - OpenServer 5.0.6 – Cannot use IDE disks that are 128 GiB or larger.

- Supported virtual disks
  - BusLogic SCSI – Requires SCO blc BTLD 3.05.1 or later.
  - LSI SCSI – Requires SCO Isil BTLD 1.03.28 or later.
  - LSI SAS – Requires LSI Logic Isil BTLD 1.04.09 or later.
  - IDE
    - Under 128GiB – no BTLD required.
    - 128GiB or more – 5.0.7 only, requires SCO “wd” BTLD.

- Downloadable drivers
  Suitable NIC and HBA drivers are not included in the base SCO OpenServer 5.0 distributions and need to be downloaded from the Internet
  - SCO Intel PRO/1000 network adapter driver (Search for the eeG driver.)
  - SCO IDE BTLD, located on the SCO FTP Web site:
  - SCO BusLogic BTLD 3.05.1, located on the SCO FTP Web site:
  - SCO LSI Logic BTLD 1.03.28, located on the SCO FTP Web site:
    ftp://ftp.sco.com/pub/openserver5/507/drivers/lsil_1.03.28/
  - LSI Logic LSISAS BTLD 1.04.09, located on the LSI Logic Web site:
    5_mpt_lsil_10409.zip
    nix_10409.txt
NOTE Floppy images must be renamed with a .flp extension to be accepted by ESX. The location of the floppy images on the LSI Web site do not appear to be static. If you cannot locate the floppy images at the addresses VMware provided, try contacting an LSI representative.

**Installation Steps**

The installation steps vary slightly between SCO OpenServer 5.0.6 and 5.0.7-MP5. These instructions document the differences.

1. Insert the SCO-OSR506-InstallCD for 5.0.6 (or SCO-OSR507-InstallCD for 5.0.7) in the CD-ROM drive. Alternatively, you can insert the SCO-OSR506-BootDisk (or SCO-OSR507-BootDisk for 5.0.7) floppy in the floppy drive.

2. Power on the virtual machine to start installing SCO OpenServer 5.0.6 or 5.0.7.

3. Install the appropriate SCSI drivers by typing one of the following boot strings:
   - IDE disk under 128GiB (137GB)
     No boot string required, press Enter.
   - IDE disk 128GiB (137GB) or larger (5.0.7 only)
     restart link="wd"
     When prompted to replace the driver, type r.
   - Buslogic
     restart link="blc" biosgeom
     When prompted to replace the driver, type r.
   - LSI Logic SCSI or SAS
     restart link="lsil" biosgeom

4. Insert the appropriate installation disks when prompted.

5. Read and accept the license agreement.

6. Accept the default CD-ROM type and controller/drive configuration.
   The Open Server 5.0 install checks for the drive type and defaults to the configuration.

7. Follow the prompts to proceed with the installation.

8. Turn off the bad block scan, which is on by default for IDE disks.
   The bad block scan is not necessary on a virtual disk.

9. When selecting the mouse, press h to specify High Resolution Keyboard Mouse.

10. Follow the remainder of the installation steps to complete the installation.

**Install Maintenance Pack 5**

After installing Open Server 5.0.7, install Maintenance Pack 5 (MP5).

1. Power on the OpenServer 5.0.7 guest.

2. If you used biosgeom during the install, boot the guest with the defbootstr biosgeom command.

3. Insert the SCO-OSR507-SuppCD5 CD in the CD-ROM drive.

4. Install MP5 using the Software Manager.

NOTE After MP5 is installed, the virtual machine will boot normally without requiring biosgeom.

This completes basic installation of the OpenServer 5.0. guest operating system.
**VMware Tools**

There is no version of VMware Tools that supports SCO OpenServer 5.0.
SCC UnixWare 7

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install SCC UnixWare 7 in a virtual machine using the standard distribution CDs, via the boot floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SCC UnixWare 7:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SCC UnixWare 7:

- SCC UnixWare 7 runs very slowly without assistance from CPU virtualization hardware. For near-native performance, the host must have support for nested page tables. This is found in AMD Barcelona and later CPUs with Rapid Virtualization Indexing (RVI) and in Intel Nehalem and later CPUs with Extended Page Tables (EPT).

**Installation Steps**

1. Insert the SCC UnixWare 7.1.1 or 7.1.4 boot CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SCC UnixWare 7.
3. If you selected LSILOGIC/LSISAS for SCSI adapter, then select Install HBA disk.
4. Insert the HBA disk.

This completes basic installation of the SCC UnixWare 7 guest operating system.

**Install SCC UnixWare Maintenance Packs**

After installing the guest operating system, install UnixWare 7.1.1 Maintenance Pack 5 (MP5) or UnixWare 7.1.4 Maintenance Pack 4 (MP4) and patch p535283, according to SCC instructions.

The Maintenance Packs are located here:

- UnixWare 7.1.1 MP5 – ftp://ftp.sco.com/pub/unixware7/uw711pk

If you use more than one virtual CPU in this guest, install the OS Multiprocessor Support (OSMP) package, which is not automatically installed. An additional SCC CPU license is required for each additional CPU. For example, if you use four virtual CPUs, you need one operating system license and three CPU licenses.

**Install and Configure SMP**

Install OSMP and any necessary licenses according to SCC documentation.

**VMware Tools**

There is no version of VMware Tools that supports SCC UnixWare.
SUSE Linux Enterprise 11

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux Enterprise 11 Desktop or Server in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux Enterprise 11 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise 11:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux Enterprise 11:

- VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the SUSE Linux Enterprise 11 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux Enterprise 11.
3. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise 11 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux Enterprise 10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux Enterprise 10 Desktop or Server in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux Enterprise 10 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise 10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux Enterprise 10:

- VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system

Installation Steps

1. Insert the SUSE Linux Enterprise 10 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux Enterprise 10.
3. Install using the text mode installer. In the first installation screen, use the arrow keys to select Installation.
4. For the Desktop, press the F2 key, use the arrow keys to choose text mode, and press Enter to select the text mode installer.
5. For the Server, enter the boot option textmode=1, and press Enter to select the text mode installer.
6. At the Installation Settings screen, go to the Change menu and choose Booting.

   The Boot Loader Setup screen appears.
7. For the Desktop edition, set the Boot Loader Type to LILO instead of the default GRUB.
8. For the Server edition, set the Boot Loader Type to the default GRUB.

   The installer displays a warning that indicates you might lose some settings and prompts you to select a course of action.
9. Select Convert current configuration and continue.
10. Select Finish to return to the Installation Settings screen.
11. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux Enterprise Server 9

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 9 in a virtual machine is to use the standard distribution CDs. However, installing SUSE Linux Enterprise Server 9 using the boot floppy/network method is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 9:

- Create and configure a new virtual machine.
- If you want support for OES 1 on SUSE Linux Enterprise Server 9, select SUSE Linux Enterprise Server 9 from the Guest Operating System version list.

Consider these support and configuration issues for SUSE Linux Enterprise Server 9:

- Only the LSI Logic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 9 virtual machine with more than 4GB of memory on ESX Server 3.x and 4.x.

Installation Steps

1. Insert the SLES 9 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SLES 9.
3. Install using the text mode installer. In the first installation screen, use the arrow keys to select Installation, enter the boot option textmode=1, and then press Enter to select the text mode installer.
4. At the Installation Settings screen, go to the Change menu and select Booting.

   The Boot Loader Setup screen appears.
5. Set the Boot Loader Type to GRUB.
6. The installer displays a warning that indicates you might lose some settings and prompts you to select a course of action. Select Convert current configuration and continue.
7. Select Finish to return to the Installation Settings screen.
8. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SLES 9 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux Enterprise Server 8

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 8 in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux Enterprise Server 8 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 8:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux Enterprise Server 8:

- Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 8 virtual machine on ESX Server 2.5.x. The LSI Logic virtual SCSI adapter is supported for SUSE Linux Enterprise Server 8 virtual machines on ESX Server 3.x and 4.x. Only the LSI Logic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 9 virtual machine with more than 4GB of memory on ESX Server 3.x and 4.x.

Installation Steps

1. Insert the SLES 8 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SLES 8.
3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.
4. Part way through the installation, the installer reboots the virtual machine. At the LILO screen, let the boot proceed using the default selection of `linux`.
5. At the Desktop Settings screen, select 640x480 256 colors.
6. Finish installing SLES 8 as you would on a physical machine.

This completes basic installation of the SLES 8 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux Enterprise Server 7

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 7 (SLES 7) in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SLES 7 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 7:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux Enterprise Server 7:

- During the SUSE Linux Enterprise Server 7 installation, a standard VGA16 X server should be installed.
  To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing SUSE Linux Enterprise Server 7.

**Installation Steps**

1. Insert the SLES 7 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SLES 7.
3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.
4. Part way through the installation, the installer reboots the virtual machine. At the LILO screen, let the boot proceed using the default selection of `linux`.
5. At the Desktop Settings screen, select `640x480 256 colors`.
6. Finish installing SLES 7 as you would on a physical machine.

This completes basic installation of the SLES 7 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).
openSUSE Linux 11.1

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing openSUSE Linux 11.1 in a virtual machine is to use the standard openSUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing openSUSE Linux 11.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install openSUSE Linux 11.1:

- Create and configure a new virtual machine.

Consider these support and configuration issues for openSUSE Linux 11.1:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the openSUSE Linux 11.1 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing openSUSE Linux 11.1.
3. Install using the text mode installer. In the first installation screen, press the F3 key to get boot options. Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE Linux 11.
   At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu, choose RPM Groups. Choose the Development group, press Enter to open it, and add gcc, gcc-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.
5. At the Test Internet Connection screen—during final configuration, after all packages are installed—do not perform the Internet connection test.
6. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the openSUSE Linux 11.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

To uninstall open-vm-tools provided by the openSUSE 11.1 distribution, see knowledge base article http://kb.vmware.com/kb/1013096.
openSUSE Linux 10.3

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing openSUSE Linux 10.3 in a virtual machine is to use the standard openSUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing openSUSE Linux 10.3 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install openSUSE Linux 10.3:

- Create and configure a new virtual machine.

Consider these support and configuration issues for openSUSE Linux 10.3:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the openSUSE Linux 10.3 installation CD in the CD-ROM drive.

2. Power on the virtual machine to start installing openSUSE Linux 10.3.

3. Install using the text mode installer. In the first installation screen, press the F3 key to get boot options. Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text mode installer.

4. Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for openSUSE Linux 10.3.

   At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu, choose RPM Groups. Choose the Development group, press Enter to open it, and add gcc, gcc-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.

5. At the Test Internet Connection screen—during final configuration, after all packages are installed—do not perform the Internet connection test.

6. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the openSUSE Linux 10.3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
openSUSE Linux 10.2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing openSUSE Linux 10.2 in a virtual machine is to use the standard openSUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing openSUSE Linux 10.2 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install openSUSE Linux 10.2:

- Create and configure a new virtual machine.
- Consider these support and configuration issues for openSUSE Linux 10.2:
  - With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the openSUSE Linux 10.2 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing openSUSE Linux 10.2.
3. Install using the text mode installer. In the first installation screen, press the F3 key to get boot options. Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for openSUSE Linux 10.2.
   - At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu, choose RPM Groups. Choose the Development group, press Enter to open it, and add gcc, g++-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.
5. At the Test Internet Connection screen—during final configuration, after all packages are installed—do not perform the Internet connection test.
6. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the openSUSE Linux 10.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 10.1

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 10.1 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 10.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 10.1:
- Create and configure a new virtual machine.
- Consider these support and configuration issues for SUSE Linux 10.1:
  - With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the SUSE Linux 10.1 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 10.1.
3. Install using the text mode installer. In the first installation screen, press the F3 key to get boot options. Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE Linux 10.
   At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu, choose RPM Groups. Choose the Development group, press Enter to open it, and add gcc, gcc-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.
5. At the Test Internet Connection screen—during final configuration, after all packages are installed—do not perform the Internet connection test.
6. Follow the remaining installation steps as you would for a physical machine.
This completes basic installation of the SUSE Linux 10.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 10.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 10.0 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 10.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 10.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 10.0:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the SUSE Linux 10.0 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 10.0.
3. Install using the text mode installer. In the first installation screen, press the F3 key to get boot options. Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE Linux 10.

   At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu, choose RPM Groups. Choose the Development group, press Enter to open it, and add gcc, gcc-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.
5. At the Test Internet Connection screen—during final configuration, after all packages are installed—do not perform the Internet connection test.
6. Follow the remaining installation steps as you would for a physical machine.

   This completes basic installation of the SUSE Linux 10.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 9.3

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 9.3 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 9.3 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.3:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.3:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
- Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux 9.3 virtual machine on ESX Server 2.5.x.

Installation Steps

1. Insert the SUSE Linux 9.3 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 9.3.
3. Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. During final configuration, after all packages are installed, do not perform the Internet connection test.
5. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 9.2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 9.2 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 9.2 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.2:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.2:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the SUSE Linux 9.2 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 9.2.
3. Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. During final configuration, after all packages are installed, do not perform the Internet connection test.
5. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 9.1

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 9.1 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 9.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.1:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.1:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. Unless you are using ESX Server 2.5.x, VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the SUSE Linux 9.1 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 9.1.
3. Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
SUSE Linux 9.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 9.0 in a virtual machine is to use the standard SUSE Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 9.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.0:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

**Installation Steps**

1. Insert the SUSE Linux 9.0 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 9.0.
3. Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to select text mode, and then press Enter to select the text mode installer.
4. Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.0 guest operating system.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2 configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 9.0 virtual machine with any of the selections offered in GRUB.
SUSE Linux 8.2

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 8.2 in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 8.2 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.2:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 8.2:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
- During the SUSE Linux 8.2 installation, do not install an X server. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing SUSE Linux 8.2.

Installation Steps

1. Insert the SUSE Linux 8.2 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 8.2.
3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.
4. Install using the text mode installer. In the first installation screen, press the F2 key, type Linux, and then press Enter to select the text mode installer.
5. When prompted, do not install an X server. In the Configure Monitor screen, choose Text Mode Only. Click Accept and finish the installation.

This completes basic installation of the SUSE Linux 8.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2 configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 8.2 virtual machine with any of the selections offered in GRUB.
SUSE Linux 8.1

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 8.1 in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 8.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.1:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 8.1:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

- During the SUSE Linux 8.1 installation, do not install an X server. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing SUSE Linux 8.1.

Installation Steps

1. Insert the SUSE Linux 8.1 installation CD in the CD-ROM drive.

2. Power on the virtual machine to start installing SUSE Linux 8.1.

3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.

4. Install using the text mode installer. In the first installation screen, press the F2 key, and then press Enter to select the text mode installer.

5. When prompted, do not install an X server. In the Configure Monitor screen, choose Text Mode Only. Click Accept and finish the installation.

This completes basic installation of the SUSE Linux 8.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2 configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 8.1 virtual machine with any of the selections offered in GRUB.
SUSE Linux 8.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 8.0 in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 8.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 8.0:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

- During the SUSE Linux 8.0 installation, do not install an X server. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing SUSE Linux 8.0.

Installation Steps

1. Insert the SUSE Linux 8.0 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 8.0.
3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.
4. Install using the text mode installer.
5. When prompted, do not install an X server. In the Configure Monitor screen, choose No X11. The installer asks you to confirm. Click Continue and finish the installation.

This completes basic installation of the SUSE Linux 8.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.

After you have installed VMware Tools, but before you start the X server, as root user, run the SaX2 configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE 8.0 virtual machine with any of the selections offered in LILO.
SUSE Linux 7.3

Be sure to read "General Installation Instructions for All VMware Products" on page 12 and this section before installing this operating system.

The easiest method of installing SUSE Linux 7.3 in a virtual machine is to use the standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE Linux 7.3 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 7.3:

- Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 7.3:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
- During the SUSE Linux 7.3 installation, do not install an X server. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing SUSE Linux 7.3.

Installation Steps

1. Insert the SUSE Linux 7.3 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing SUSE Linux 7.3.
3. Follow the installation steps as you would for a physical machine until you get to the selection screens described in the next steps.
4. Install using the text mode installer.
5. When prompted, do not install an X server. In the Configure Monitor screen, choose No X11. The installer asks you to confirm. Click Continue and finish the installation.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, you can boot your SUSE 7.3 virtual machine with any of the selections offered in LILO.
**Turbolinux 10**

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Turbolinux 10 Desktop or Server in a virtual machine is to use the standard Turbolinux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing Turbolinux 10 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Turbolinux 10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

**Installation Steps**

1. Insert the Turbolinux 10 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Turbolinux 10.
3. Follow the installation steps as you would for a physical machine.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
Turbolinux 8

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Turbolinux 8 Workstation or Enterprise Server in a virtual machine is to use the standard Turbolinux distribution CDs. The notes below describe an installation using the standard distribution CD; however, installing Turbolinux 8 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 8:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Turbolinux 8:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

- During the Turbolinux 8 installation, do not install an X server. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing Turbolinux 8.

Installation Steps

1. Insert the Turbolinux 8 installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Turbolinux 8.
3. Follow the installation steps as you would for a physical machine, until you get to the selection screens described in the next steps.
4. Install using the text mode installer. In the first installation screen, press the F2 key, and then press Enter to select the text mode installer.
5. When prompted, do not install an X server. In the Desktop Settings screen, choose Text Mode Only. Click Accept and finish the installation.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as root user, run the SaX2 configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2, you can boot your Turbolinux Workstation 8 virtual machine with any of the selections offered in GRUB.
Turbolinux 7.0

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Turbolinux 7.0 in a virtual machine is to use the standard Turbolinux 7.0 distribution CD. The notes below describe an installation using the standard distribution CD; however, installing Turbolinux 7.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 7.0:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Turbolinux 7.0:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
- During the Turbolinux 7.0 installation, a standard VGA16 X server (without support for the VMware display adapter) is installed. To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools package immediately after installing Turbolinux 7.0, before you start the X server.

Installation Steps

1. Insert the Turbolinux 7.0 CD No. 1 in the CD-ROM drive.
2. Power on the virtual machine to start installing Turbolinux 7.0.
3. Follow the installation steps as you would for a physical PC until you get to the selection screen described in the next step.
4. In the Configure Monitor screen, follow the defaults to configure an X server. This is necessary even though you will install a different X server with VMware Tools after you finish installing the guest operating system.
5. Finish installing Turbolinux 7.0 as you would on a physical computer.

At this point Turbolinux 7.0 boots and a login screen appears.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
Ubuntu 9.10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu 9.10 in a virtual machine is to use the standard Ubuntu 9.10 distribution CD.

Fulfill these requirements before you install Ubuntu 9.10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu 9.10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu 9.10 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu 9.10.
3. After the Ubuntu 9.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Ubuntu 9.10 user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

NOTE For Ubuntu 9.10, install VMware Tools using the tar installer.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.
Ubuntu 9.04

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu 9.04 in a virtual machine is to use the standard Ubuntu 9.04 distribution CD.

Fulfill these requirements before you install Ubuntu 9.04:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu 9.04:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu 9.04 CD in the CD-ROM drive.


3. After the Ubuntu 9.04 installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.

4. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt/ Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Ubuntu 9.04 user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

**NOTE** For Ubuntu 9.04, install VMware Tools using the tar installer.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

**To enable root in a virtual machine running Ubuntu**

Ubuntu Server Edition

1. Open a terminal window.

2. Log in as a normal user.

3. Type `sudo passwd root` to set a root password.

Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.

2. Select the Allow local system administrator login check box and click Close.

3. Select System > Administration > Users and Groups and click Unlock.
4 In the **Authenticate** window, type your password and click **Authenticate**.

5 Select root, click **Properties**, and under **Set password by hand**, establish a root password.
Ubuntu 8.10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu 8.10 in a virtual machine is to use the standard Ubuntu 8.10 distribution CD.

Fulfill these requirements before you install Ubuntu 8.10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu 8.10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu 8.10 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu 8.10.
3. After the Ubuntu 8.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt/ Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Ubuntu 8.10 user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** For Ubuntu 8.10, install VMware Tools using the tar installer.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

**To enable root in a virtual machine running Ubuntu**

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.

Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4 In the Authenticate window, type your password and click Authenticate.

5 Select root, click Properties, and under Set password by hand, establish a root password.
Ubuntu 8.04 LTS

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu 8.04 LTS in a virtual machine is to use the standard Ubuntu 8.04 LTS distribution CD.

Fulfill these requirements before you install Ubuntu 8.04 LTS:
- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu 8.04 LTS:
- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu 8.04 LTS CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu 8.04 LTS.
3. After the Ubuntu 8.04 LTS installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Ubuntu 8.04 LTS user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

NOTE For Ubuntu 8.04 LTS, 8.04.1, and 8.04.2, you can install VMware Tools using the tar installer or the appropriate OSP. For a complete set of instructions for downloading, installing, and upgrading VMware Tools OSPs, see the VMware Tools Installation Guide Operating System Specific Packages at: http://www.vmware.com/pdf/osp_install_guide.pdf

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type sudo passwd root to set a root password.
Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4. In the Authenticate window, type your password and click Authenticate.
5. Select root, click Properties, and under Set password by hand, establish a root password.
Ubuntu Linux 7.10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 7.10 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 7.10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 7.10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt/Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, in the Ubuntu Linux user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

**To enable root in a virtual machine running Ubuntu Linux**

**Ubuntu Server Edition**

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.

**Ubuntu Desktop Edition**

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4 In the **Authenticate** window, type your password and click **Authenticate**.

5 Select root, click **Properties**, and under **Set password by hand**, establish a root password.
Ubuntu Linux 7.04

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 7.04 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 7.04:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 7.04:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

**NOTE** As the installation progresses, the message Configuring apt: Scanning the mirror appears indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning eventually stops and the installation resumes. When the installation completes, from the Ubuntu Linux user interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

Ubuntu Server Edition

1. Open a terminal window and log in as a normal user.
2. Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4. In the Authenticate window, type your password and click Authenticate.
5. Select root, click Properties, and under Set password by hand, establish a root password.
Ubuntu Linux 6.10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 6.10 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 6.10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 6.10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE**  You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

**Ubuntu Server Edition**

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.

**Ubuntu Desktop Edition**

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4. In the Authenticate window, type your password and click Authenticate.
5. Select root, click Properties, and under Set password by hand, establish a root password.
Ubuntu Linux 6.06

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 6.06 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 6.06:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 6.06:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

NOTE  You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can complete the following steps either before or during the VMware Tools installation.

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4. In the Authenticate window, type your password and click Authenticate.
5. Select root, click Properties, and under Set password by hand, establish a root password.
Ubuntu Linux 5.10

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 5.10 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 5.10:

- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 5.10:

- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD and displays a message indicating that the computer will restart. If the virtual machine fails to restart as expected, click the Reset button to restart it.
4. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest.

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.

Ubuntu Desktop Edition

1. Select System > Administration > Login Window, and click the Security tab.
2. Select the Allow local system administrator login check box and click Close.
3. Select System > Administration > Users and Groups and click Unlock.
4. In the Authenticate window, type your password and click Authenticate.
5. Select root, click Properties, and under Set password by hand, establish a root password.

VMware Tools and 64-bit Version of Ubuntu Linux 5.10

The 64-bit version of Ubuntu Linux 5.10 lacks the driver needed for correct operation of the X server in the virtual machine. The driver is installed when you install VMware Tools. To install VMware Tools in the 64-bit version of Ubuntu Linux 5.10, see knowledge base article at http://kb.vmware.com/kb/1900.
Ubuntu Linux 5.04

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing Ubuntu Linux 5.04 in a virtual machine is to use the standard Ubuntu Linux distribution CD.

Fulfill these requirements before you install Ubuntu Linux 5.04:
- Create and configure a new virtual machine.

Consider these support and configuration issues for Ubuntu Linux 5.04:
- With many Linux guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the Ubuntu Linux CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Ubuntu Linux.
3. If your host computer is on a network that uses a proxy server for Internet access, enter information about the proxy server name and port at the boot prompt.
   ```
   linux http_proxy=http://<proxy_server>:<port_number>
   ```
4. Follow the installation steps as you would for a physical PC.
   You can now become root at any time using the normal `su` command and the root password you just created.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest.

Ubuntu Server Edition

1. Open a terminal window.
2. Log in as a normal user.
3. Type `sudo passwd root` to set a root password.

Ubuntu Desktop Edition

1. Select **System > Administration > Login Window**, and click the **Security** tab.
2. Select the **Allow local system administrator login** check box and click **Close**.
3. Select **System > Administration > Users and Groups** and click **Unlock**.
4. In the **Authenticate** window, type your password and click **Authenticate**.
5. Select root, click **Properties**, and under **Set password by hand**, establish a root password.
FreeBSD 7

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

Install FreeBSD 7 from a DVD or CDs.

Fulfill these requirements before you install FreeBSD 7:
- Create and configure a new virtual machine.
- Download the ISO images from the FreeBSD Web site.

Consider these support and configuration issues for FreeBSD 7:
- With many FreeBSD guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 7:
1. Insert the FreeBSD 7 CD or DVD into the CD-ROM drive.
2. Power on the virtual machine to start installing FreeBSD.
3. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
FreeBSD 6

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install FreeBSD 6 from a DVD or CDs.

Fulfill these requirements before you install FreeBSD 6:

- Create and configure a new virtual machine.
- Download the ISO images from the FreeBSD Web site:

Consider these support and configuration issues for FreeBSD 6:

- With many FreeBSD guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 6:

1. Insert the FreeBSD CD in the CD-ROM drive.
2. Power on the virtual machine to start installing FreeBSD.
3. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
FreeBSD 5

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing FreeBSD 5 in a virtual machine is to use the standard FreeBSD distribution CD.

Fulfill these requirements before you install FreeBSD 5:

- Create and configure a new virtual machine.

Consider these support and configuration issues for FreeBSD 5:

- With many FreeBSD guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1. Insert the FreeBSD 5 CD in the CD-ROM drive.
2. Power on the virtual machine to start installing FreeBSD 5.
3. Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
FreeBSD 4

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

The easiest method of installing FreeBSD 4 in a virtual machine is to use the standard FreeBSD distribution CD.

Fulfill these requirements before you install FreeBSD 4:

- Create and configure a new virtual machine.

Consider these support and configuration issues for FreeBSD 4:

- With many FreeBSD guest operating systems, various problems have been observed when the BusLogic virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
- VMware recommends that you configure ESX Server virtual machines that use this guest operating system to use the vmx Ethernet adapter. See your product documentation for instructions.
- FreeBSD 4.6 is not supported. Use FreeBSD 4.6.2 instead. It resolves an issue that interferes with installation of FreeBSD 4.6 in a virtual machine.

Installation Steps

1. Insert the FreeBSD CD in the CD-ROM drive.
2. Power on the virtual machine to start installing FreeBSD.
3. Follow the rest of the installation steps as you would for a physical PC.

Additional Install Instructions for FreeBSD 4.11, 4.10, and 4.9

After powering on the virtual machine complete this step:

In the FreeBSD Disklabel Editor step, do not use the installer’s default option A partitioning. Use option C to create the mounts. In order to install VMware Tools, you need more space in /usr than is provided by the installer defaults. Include at least 4,000,000 blocks for /usr in the partitioning scheme.

Additional Install Instructions for FreeBSD 4.3, 4.2, 4.1, and 4.0

If you create your virtual machine with a virtual IDE disk, installation proceeds as it would on a physical machine. If you create your virtual machine with a SCSI virtual disk that is 2GB or larger you need to set the disk geometry.

If you install FreeBSD 4.3, 4.2, 4.1, and 4.0 as the guest operating system on a 2GB or larger SCSI virtual disk, the guest operating system does not boot unless you take special steps.

The guest fails to boot because the virtual disk geometry is not probed correctly by FreeBSD when you install the guest operating system. FreeBSD installs the boot loader in the wrong location on the virtual disk. When FreeBSD tries to boot, the FreeBSD boot loader asks the BIOS for important data that is now on a different section of the virtual disk, so FreeBSD cannot boot.

This problem has been fixed in FreeBSD 4.4. This and later versions correctly boot SCSI virtual disks of any size.

To use FreeBSD 4.3, 4.2, 4.1, and 4.0 in your virtual machine, complete one of these tasks

- Use an IDE virtual disk in your virtual machine. You might need to add the IDE virtual disk to the virtual machine with the Configuration Editor.
- Manually set the disk geometry when installing FreeBSD.
To set the disk geometry manually

1 FreeBSD calculates an incorrect disk geometry before you arrive at the FDISK Partition Editor, as the following illustrates.

2 To set the disk geometry, press G to select the option **Set Drive Geometry**. A dialog box appears, containing numbers like 2055/64/32, representing the incorrect geometry in cylinders, heads and sectors per head.

3 To calculate the correct geometry, find the total number of sectors by multiplying the number of cylinders, heads and sectors per head together, and then dividing the number of sectors by the correct number of heads and sectors per head.

   In the screen shot in step 2, the virtual disk is a 2055MB disk with 2055 cylinders, 64 heads and 32 sectors per head (these numbers represent the incorrect geometry). The product of these three numbers (2055 x 64 x 32) equals 4,208,640 sectors.

   To determine the correct geometry for the BusLogic compatible virtual SCSI adapter used by the virtual machine, calculate the number of cylinders, which is 4,208,640 sectors divided by the product of the actual number of heads and sectors per head (255 heads times 63 sectors per head). This results in a total of 261 actual cylinders (4208640/(255 * 63) = 261, rounded down).

4 You can now enter the correct geometry of 261 cylinders, 255 heads and 63 sectors per head by typing 261/255/63 in the dialog box. Then click **OK** and continue installing FreeBSD.
VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.
NetWare 6.5 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install NetWare 6.5 in a virtual machine using the standard Novell NetWare 6.5 Operating System and Product CD-ROMs.

Fulfill these requirements before you install NetWare 6.5 Server:

- Create and configure a new virtual machine.
- When you create a virtual machine for NetWare 6.5 with Novell Open Enterprise Server on an ESX Server, select Novell NetWare for the guest operating system and Novell NetWare 6.x for the version.

Consider these support and configuration issues for NetWare 6.5:

- VMware recommends you install NetWare 6.5 on a computer with at least 512MB of memory.
- Guests without Support Pack 1: Read the Novell technical information document at support.novell.com/cgi-bin/search/searchtid.cgi?/2967370.htm. This document describes the steps necessary to download and install a NetWare patch required when you install a NetWare 6.5 Server guest operating system without SP1.
- When you configure a virtual machine for a NetWare 6.5 guest, use the virtual LSI Logic SCSI adapter. NetWare 6.5 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1. Insert the Novell NetWare 6.5 Product CD in the CD-ROM drive.
2. Power on the virtual machine to start installing NetWare 6.5.
3. Read and accept the license agreement.

**NOTE** A few prompts appear before you reach the license agreement. Accept the defaults for installing NetWare, the CD-ROM drive type, how to restore the floppy drive and the run mode, and then continue.

4. When prompted, choose IDE CD-ROM.
5. Create a new boot partition. The guest operating system reboots. The installation continues.
6. **VMware ESX Server:** Jump to Step 7.

**VMware Workstation, VMware ACE and VMware GSX Server:** To configure IP networking, do one of the following:

- If you chose bridged networking for the virtual machine, enter its IP address.
  
  When NetWare tries to load the LAN driver (using pcntnw.1an), it fails because it broadcasts for its own IP address. This causes IP networking to fail.

  To work around this, open the System Console (press Ctrl+Esc) and type

  ```
  set allow ip address duplicates=on
  ```

  Press Alt+Esc to return to the installation.

- If you chose host-only networking for the virtual machine, look up the host machine's IP address.
  
  At a command prompt on a Windows host, type

  ```
  ipconfig /all
  ```

  At a command prompt on a Linux host, type

  ```
  ifconfig
  ```
Note the host’s IP address for VMnet1 and change the last octet so it is greater than the last octet in the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###, where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.

For the router gateway, enter the host’s IP address (192.168.160.1 in our example).

- If you chose network address translation (NAT) for the virtual machine, look up the host machine’s IP address.

  At a command prompt on a Windows host, type

  `ipconfig /all`

  At a command prompt on a Linux host, type

  `ifconfig`

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###, where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.

For the router gateway, enter the NAT service’s IP address (192.168.160.2 in our example).

Note that with Network Address Translation, there are 2 IP addresses in use on the host:

- The IP address assigned to the interface for VMnet8 (which shows up in the `ipconfig` output with a ".1" in the last octet).
- The IP address used by the NAT device itself (which always uses ".2" as the last octet).

7 Finish the installation by following the on-screen instructions.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
NetWare 6.0 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install NetWare 6.0 in a virtual machine using the standard Novell NetWare 6.0 CD-ROM.

Fulfill these requirements before you install NetWare 6.0 Server:

- Create and configure a new virtual machine.

Consider these support and configuration issues for NetWare 6.0 Server:

- VMware recommends you install NetWare 6 on a computer with at least 256MB of memory.
- In the NetWare installation process, you must boot from the installation CD twice—once to format the virtual machine's disk drive, and then a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears, press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.

- When you configure a virtual machine for a NetWare 6.0 guest, use the virtual LSI Logic SCSI adapter. NetWare 6.0 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1. Insert the NetWare 6.0 Server CD in the CD-ROM drive.
2. Power on the virtual machine to start installing NetWare 6.0.
3. Read and accept the license agreement.
4. When prompted, choose IDE CD-ROM.
5. Create a new boot partition. The guest operating system reboots.
6. To configure IP networking, do one of the following:
   - If you chose bridged networking for the virtual machine, enter its IP address.
     When NetWare tries to load the LAN driver (using pcntnw.1an), it fails because it broadcasts for its own IP address. This causes IP networking to fail.
     To work around this, open the System Console (press Ctrl+Esc) and type

     ```
     set allow ip address duplicates=on
     ```
     Press Alt+Esc to return to the installation.
   - If you chose host-only networking for the virtual machine, look up the host machine's IP address.
     At a command prompt on a Windows host, type

     ```
     ipconfig /all
     ```
     At a command prompt on a Linux host, type

     ```
     ifconfig
     ```
     Note the host's IP address for VMnet1 and change the last octet so it is greater than the last octet in the IP address of the host.
     For example, if the host IP address is 192.168.160.1, the virtual machine's IP address is 192.168.160.###, where ### is any number greater than 1 and less than 128.
     For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the host's IP address (192.168.160.1 in this example).

- If you chose network address translation (NAT) for the virtual machine, look up the host machine's IP address.

At a command prompt on a Windows host, type

```
ipconfig /all
```

At a command prompt on a Linux host, type

```
ifconfig
```

Note the host's IP address for VMnet8 and change the last octet so it is greater than the last octet in the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine's IP address is 192.168.160.##, where ## is any number greater than 2 and less than 128.

For the subnet mask, enter `255.255.255.0`.

For the router gateway, enter the NAT service's IP address (192.168.160.2 in this example).

Note that with Network Address Translation, there are two IP addresses in use on the host:

- The IP address assigned to the interface for VMnet8 appears in the `ipconfig` output with a 1 in the last octet.
- The IP address used by the NAT device itself always uses 2 as the last octet.

7 Finish the installation.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
NetWare 5.1 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install NetWare 5.1 Server in a virtual machine using the standard Novell NetWare 5.1 Server CD-ROM.

Fulfill these requirements before you install NetWare 5.1 Server:

- Create and configure a new virtual machine.

Consider these support and configuration issues for NetWare 5.1 Server:

- VMware recommends you install NetWare 5.1 on a computer with at least 256MB of memory.
- If you are running NetWare 5.1 Server Support Pack 6, you should install the latest LSI Logic SCSI driver. For information on obtaining and installing the driver, see http://kb.vmware.com/kb/1181.
- For SCSI support, be sure to download the latest LSI Logic driver.
- In the NetWare installation process, boot from the installation CD twice—once to format the virtual machine’s disk drive, and a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears, press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.

Installation Steps

1. Insert the NetWare 5.1 Server CD into the CD-ROM drive.
2. Power on the virtual machine to start installing NetWare 5.1.
3. Read and accept the license agreement.
4. Create a new boot partition. The guest operating system reboots. The installation continues.
5. **VMware ESX Server:** Skip to Step 6.

**VMware Workstation, VMware ACE and VMware GSX Server:** To configure IP networking, do one of the following:

- If you chose bridged networking for the virtual machine, enter its IP address.

  When NetWare tries to load the LAN driver (using pcntnw.1on), it fails because it broadcasts for its own IP address. This causes IP networking to fail.

  To work around this, open the System Console (press Ctrl+Esc) and type

    `set allow ip address duplicates=on`

  Press Alt+Esc to return to the installation.

- If you chose host-only networking for the virtual machine, look up the host machine’s IP address.

  At a command prompt on a Windows host, type

    `ipconfig /all`

  At a command prompt on a Linux host, type

    `ifconfig`

  Note the host’s IP address for VMnet1 and change the last octet so it is greater than the last octet in the IP address of the host.
For example, if the host IP address is 192.168.160.1, and then the virtual machine’s IP address is 192.168.160.###, where ### is any number greater than 1 and less than 128.

For the subnet mask, enter **255.255.255.0**.

For the router gateway, enter the host’s IP address (192.168.160.1 in this example).

- If you chose network address translation (NAT) for the virtual machine, look up the host machine’s IP address.

  At a command prompt on a Windows host, type
  ```
  ipconfig /all
  ```
  At a command prompt on a Linux host, type
  ```
  ifconfig
  ```

  Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in the IP address of the host.

  For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###, where ### is any number greater than 2 and less than 128.

  For the subnet mask, enter **255.255.255.0**.

  For the router gateway, enter the NAT service’s IP address (192.168.160.2 in this example).

  Note that with Network Address Translation, there are two IP addresses in use on the host:
  - The IP address assigned to the interface for VMnet8 shows up in the `ipconfig` output with a 1 in the last octet.
  - The IP address used by the NAT device itself always uses 2 as the last octet.

6 Finish the installation by following the on-screen instructions.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
NetWare 4.2 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

You can install NetWare 4.2 Server in a virtual machine using the standard Novell NetWare 4.2 Server installation CD.

Fulfill these requirements before you install NetWare 4.2 Server:

- Create and configure a new virtual machine.

- If you created this virtual machine on a Linux host follow these steps:
  a. Open the configuration file (<netware>.cfg) in a text editor and add the following line:
     
     
     gui.iconLEDs = false
  
  b. This removes all the LED icons in the console window, which prevents the virtual machine display from appearing incorrectly when you power it on while the host is in 8 bit/256 color mode.
  
  c. Install the guest operating system and VMware Tools, which includes the CPU idler program. See “VMware Tools” on page 124

Consider these support and configuration issues NetWare 4.2 Server:

- VMware recommends you install NetWare 4.2 Server on a host with at least 256MB of memory.

Installation Steps

1. VMware recommends that you install MS-DOS 5.0 or higher in a small (50MB FAT16) partition as described in these guidelines. The rest of the free space on the virtual disk is used for the NetWare partition. Even if the virtual machine is to run NetWare most of the time, it is a good idea to install a CPU idler program.

2. Install a CD-ROM driver or CD-ROM software for MS-DOS. If you have problems setting up the MS-DOS virtual machine to access the CD-ROM drive, you can use the mtmcdai.sys driver, which can be found at www.mitsumi.com. Under Drivers and Manuals look for ide158.exe.

3. Modify the config.sys and autoexec.bat files on your MS-DOS boot floppy (along with the mscdex.exe file) as shown below. If you are using a MS-DOS boot partition, adjust the drive letters accordingly.

   config.sys
   device=himem.sys /testmem:off
   device=NEC_IDE.SYS /D:MSCD001
   files=12
   buffers=15
   stacks=9,256
   lastdrive=z

   autoexec.bat
   @ECHO OFF
   set EXPAND=YES
   SET DIRCMD=/O:N
   cls
   set temp=c:
   set tmp=c:
   path=c:

   IF "%config%"="NOCD" GOTO QUIT
   a:\NWCDEX.EXE /D:mscd001

   :QUIT

After you have configured the CD-ROM software, verify that the virtual machine can read a CD from the host system's CD-ROM drive.
If the virtual machine is not running, power it on and wait for MS-DOS to finish its boot process.

Insert the NetWare 4.2 CD in the CD-ROM drive on the GSX Server host.

In the virtual machine, at the MS-DOS prompt, run `fdisk` to create a partition for NetWare.

```
A:\>fdisk
```

After you create the partition, reboot the virtual machine. Press Ctrl+Alt+Insert.

```
format c: /s /x
```

Copy the following files to your C: drive from your floppy. Type the following:

```
Copy autoexec.bat c:
Copy config.sys c:
Copy himem.sys c:
Copy nwcdex.exe c:
Copy nec_ide.sys c:
```

Modify the `autoexec.bat` file so it points to the CD-ROM directory on the hard drive instead of the floppy drive.

a. To modify `autoexec.bat`, type the following at the C: prompt:

```
a:\edit autoexec.bat
```
b. The line

```
a:\NWCDEX.EXE /D:mscd001
```
Must be changed to

```
c:\NWCDEX.EXE /D:mscd001
```
c. Save the changes you just made.

```
cd d:
```

Run `INSTALL.BAT` to start the NetWare server installation process. Install the software in a virtual machine as you would for a physical PC.

If the virtual machine has been configured for networking (bridged, host-only, NAT or custom), the installation program detects a PCl Ethernet adapter and prompts you with a list of possible drivers. At this point, do not select or load any LAN drivers; press the F3 key to continue installing without a LAN driver.

**NOTE** Once the installation has been completed, you can load and bind the appropriate LAN driver. Selecting or loading a LAN driver during the NetWare 4.2 installation might hang the installation process.

Finish the NetWare 4.2 installation by following the on-screen instructions.

Then shut down the server and type `exit` to return to a MS-DOS prompt.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

**VMware Tools**

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at [http://kb.vmware.com/kb/340](http://kb.vmware.com/kb/340).

In NetWare 4.2 virtual machines, VMware Tools provides CPU idling, sends a heartbeat from the guest operating system to the host and gives the virtual machine the ability to be gracefully powered on or off. Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
Solaris 10 Operating System for x86 Platforms

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

VMware products support only the version for x86 platforms. You cannot install the version for SPARC platforms in a VMware virtual machine.

The easiest method of installing the Solaris 10 Operating System in a virtual machine is to use the standard Solaris 10 for x86 installation media. The notes below describe an installation using the CD set or DVD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Solaris 10 Operating System:

- Create and configure a new virtual machine.

Consider these support and configuration issues for a Solaris 10 Operating System:

- 64-bit Solaris 10 guests support only the e1000 network adapter driver.

- VMware Server or ESX Server:
  - Starting with the Solaris 10 1/06 release, Sun recommends 512MB of memory. 256MB is the minimum requirement.
  - For the Solaris 10 3/05 release, Sun recommends 256MB of memory. 128MB is the minimum requirement.
  - Before upgrading a virtual machine’s guest operating system to the Solaris 10 1/06 release or later, increase the virtual machine’s RAM to at least 256MB. See your VMware product documentation for instructions. For more information see the System Requirements and Recommendations for Solaris 10 Installation, on the Sun Web site at: http://docs.sun.com/app/docs/doc/817-0544/6mgbagb0v?a=view

Installation Steps

1. Insert the Solaris 10 Operating System for x86 Platforms DVD or the Solaris 10 Software 1 CD in the DVD or CD-ROM drive.
2. Power on the virtual machine to start installing Solaris 10.
3. Follow the installation steps as you would for a physical machine.

This completes basic installation of the Solaris 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base article 340 at http://kb.vmware.com/kb/340.

**NOTE** On ESX, VMware Tools is supported on ESX 3.x and later.
Solaris 9 Operating System x86 Platform Edition

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a VMware virtual machine.

The easiest method of installing the Solaris 9 Operating System in a virtual machine is to use the standard Solaris x86 Platform Edition Installation CD. The notes below describe an installation using the CD. If your VMware product supports it, you might also install from a PXE server.

Fulfill these requirements before you install a Solaris 9 Operating System:

- Create and configure a new virtual machine.
- Consider these support and configuration issues for a Solaris 9 Operating System:
  - If you want to use a SCSI hard disk in your virtual machine, configure the virtual machine to use the LSI Logic adapter and use Solaris 9 9/04 or a later release. An LSI Logic driver is included in releases beginning with Solaris 9 9/04. If you use an earlier release of Solaris 9 and configure the virtual machine to use a SCSI hard disk, you must get the LSI Logic driver and install it as an install time update. To locate the driver, go to the LSI Logic download page at www.lsi.com/support/download_center/ and choose LSI53C1030 from the Select a Specific Product drop-down list.

Installation Steps

In most respects, you should follow the installation steps as you would for a physical machine.

1. Insert the Solaris 9 x86 Platform Edition installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Solaris 9.
4. In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings. Press Enter to select it, and press F2 to continue.
5. Use the arrow keys to select the property ata-dma-enabled. Press Enter to select it and press F3 to change the value.
6. Type 1 and press Enter to enable DMA at the Specify Value prompt.
8. Choose CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the installation.

To configure the X server

Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity — after all the software is installed and before configuring the X server.

1. When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the X server and continue with the installation.
   After the software installation completes, the installer prompts you for the root password to configure the X Server (Windows System Configuration).
2. Enter the root password. The kdmconfig Mismatch Detected screen appears. Press F2 to configure.
3. Select the default option, Change Video Device/Monitor, and press F2 to continue.
4. Press Enter to select 16 color Standard VGA 640x480 (256K) and press F2 to continue.
5. Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz). Press Enter and press F2 to continue.
6 Do not change the default screen size of 17 inches. Press F2 to continue.
7 Do not change the default option 640x480. Press F2 in the Virtual Screen Resolution Selection screen.
8 Do not change the default of No changes needed – Test/Save and Exit. Press F2 to continue.
9 Press F4 to bypass the Windows System Configuration tests.
10 Follow the prompts to complete the installation.

This completes the basic installation of the Solaris 9 guest operating system and KDM X server.

**VMware Tools**

There is no version of VMware Tools that supports Solaris 9.
Solaris 8 Operating System x86 Platform Edition

Be sure to read “General Installation Instructions for All VMware Products” on page 12 and this section before installing this operating system.

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a VMware virtual machine.

The easiest method of installing the Solaris 8 x86 in a virtual machine is to use the standard Solaris 8 x86 Platform Edition Installation CD. If your VMware product supports it, you might also install from a PXE server.

Fulfill these requirements before you install a Solaris 8 Operating System:

- Create and configure a new virtual machine.

Consider these support and configuration issues for a Solaris 8 Operating System:

- The Solaris 8 installation CD does not include the Solaris 8 SCSI (LSI/LSISAS) drivers. If you select LSI/LSISAS drivers when installing the guest on the virtual machine, it will not detect the SCSI hard disk unless you install the drivers during the Solaris 8 installation. As a result, you need to create an Install Time Update (ITU) driver disk.
- If you plan to use a SCSI hard drive, see “Adding a SCSI Driver” on page 129.
- If you selected an IDE controller, begin installing Solaris 8 by following the “Installation Steps” on page 128.

Installation Steps

In most respects, you should follow the installation steps as you would for a physical machine.

1. Insert the Solaris 8 x86 Platform Edition installation CD in the CD-ROM drive.
2. Power on the virtual machine to start installing Solaris 8.
4. In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings. Press Enter to select it, and press F2 to continue.
5. Use the arrow keys to select the property ata--dma--enabled. Press Enter to select it and press F3 to change the value.
6. Type 1 and press Enter to enable DMA at the Specify Value prompt.
8. Choose CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the installation.

To configure the X server

Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity — after all the software is installed and before configuring the X server.

1. When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the X server and continue with the installation.
   After the software installation completes, the installer prompts you for the root password to configure the X Server (Windows System Configuration).
2. Enter the root password. The kdmconfig Mismatch Detected screen appears. Press F2 to configure.
3. Select the default option, Change Video Device/Monitor, and press F2 to continue.
4. Press Enter to select 16 color Standard VGA 640x480 (256K) and press F2 to continue.
5 Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz). Press Enter and press F2 to continue.

6 Do not change the default screen size of 17 inches. Press F2 to continue.

7 Do not change the default option 640x480. Press F2 in the Virtual Screen Resolution Selection screen.

8 Do not change the default of No changes needed – Test/Save and Exit. Press F2 to continue.

9 Press F4 to bypass the Windows System Configuration tests.

10 Follow the prompts to complete the installation.

This completes the basic installation of the Solaris 8 guest operating system and KDM X server.

Adding a SCSI Driver
To add a SCSI drive, first create a driver disk with the Solaris 8 drivers. During installation when you install the drivers, the drivers detect the SCSI hard drive.

Download SCSI drivers for Solaris 8 from the LSI Web site:

http://www.lsi.com/DistributionSystem/AssetDocument/itmpt_x86_5.07.04.zip

Creating an ITU Driver Disk Using Solaris
Use the existing dd image itmpt-x86-50704-itu-s9.dd file in the zip file to create the driver disk.

Type the following command to create the driver disk:

```
dd if=itmpt-x86-50704-itu-s9.dd of=/vol/dev/aliases/floppy0 bs=32768
```

**NOTE** If you want to use Windows to create the disk, refer to the instructions in `itmpt_x86_5.07.04.txt` in the zip file.

Detecting the SCSI Hard Drive
These instructions apply to both SCSI and LSI/LSI SAS.

1 When you begin the installation, press F4 in the Solaris Device Configuration Assistant screen to add the drivers.

2 Insert the ITU disk (connect the Floppy drive to A: in the virtual machine) and press F2 to continue.
   
   The disk loads the software on the virtual machine.

3 In the Continue Supplement Driver Installation screen, first disconnect the disk and then press F4.

4 Press F2 to continue the installation in the Identified Device Drivers screen. Then follow the rest of the installation steps from Step 3 in “Installation Steps” on page 128.

VMware Tools
There is no version of VMware Tools that supports Solaris 8.
Index

A
Asianux 3.0
installing guest operating system 31

C
CentOS 4
installing guest operating system 33
CentOS 5
installing guest operating system 32
CPU idle program
MS-DOS 6.22 30
NetWare 4.2 Server 124
NetWare 5.1 Server 122
NetWare 6.0 Server 120
NetWare 6.5 Server 118
create boot disks
IBM OS/2 4.0 guest 39
IBM OS/2 Warp 4.5.2 guest 37

D
Debian 4.0
installing guest operating system 35
Debian 5.0
installing guest operating system 34
disks, using multiple in Windows NT guest 23
DMA
enabling in Windows 95 guest 28
enabling in Windows NT guest 23
download maintenance packs for SCO UnixWare 7
guest 75
downloading drivers for SCO OpenServer 5.0 72
drive sizes for SCO OpenServer 5.0 72

E
eComStation 1.0
installing guest operating system 36

F
floppy disk installation for Windows 98 26
format virtual disk 12
FreeBSD 4
installing guest operating system 114
FreeBSD 4.0, 4.1, 4.2, 4.3
installing guest operating system 114
FreeBSD 4.11, 4.10, 4.9
installing guest operating system 114
FreeBSD 4.3, 4.2, 4.1, 4.0
installing guest operating system 114
FreeBSD 5
installing guest operating system 113
FreeBSD 6
installing guest operating system 112
FreeBSD 7
installing guest operating system 111

G
GSX Server sound adapter 12
guest operating systems licenses 13

I
IBM OS/2 Warp 4.0
create boot disks 39
installing guest operating system 39
IBM OS/2 Warp 4.5.2
create boot disks 37
installing guest operating system 37
installing guest operating system
Asianux 3.0 guest 31
CentOS 4 guest 33
CentOS 5 guest 32
Debian 4.0 guest 35
Debian 5.0 34
eComStation 1.0 guest 36
FreeBSD 4 guest 114
FreeBSD 4.0, 4.1, 4.2, 4.3 guest 114
FreeBSD 4.3, 4.2, 4.1, 4.0 guest 114
FreeBSD 5 guest 113
FreeBSD 6 guest 112
FreeBSD 7 guest 111
FreeBSD 4.11, 4.10, 4.9 guest 114
IBM OS/2 Warp 4.0 guest 39
IBM OS/2 Warp 4.5.2 guest 37
Mac OS X Server 10.5 guest 41
Mandrake Linux 10 guest 48
Mandrake Linux 8 guest 51
Mandrake Linux 8.1, 8.0 guest 51
Mandrake Linux 8.2 guest 51
Mandrake Linux 9 guest 49
Mandrake Linux 9.0 guest 50
Mandriva Corporate 4 guest 43
Mandriva Linux 2006 guest 47
Mandriva Linux 2007 guest 46
<table>
<thead>
<tr>
<th>Operating System</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandriva Linux 2008 guest</td>
<td>45</td>
</tr>
<tr>
<td>Mandriva Linux 2009 guest</td>
<td>44</td>
</tr>
<tr>
<td>MS-DOS 6.22 guest</td>
<td>29</td>
</tr>
<tr>
<td>NetWare 4.2 Server guest</td>
<td>123</td>
</tr>
<tr>
<td>NetWare 5.1 Server guest</td>
<td>121</td>
</tr>
<tr>
<td>NetWare 6.0 Server guest</td>
<td>119</td>
</tr>
<tr>
<td>NetWare 6.5 Server guest</td>
<td>117</td>
</tr>
<tr>
<td>Novell Linux Desktop 9 guest</td>
<td>53</td>
</tr>
<tr>
<td>openSUSE Linux 10.2 guest</td>
<td>83</td>
</tr>
<tr>
<td>openSUSE Linux 10.3 guest</td>
<td>82</td>
</tr>
<tr>
<td>openSUSE Linux 11.1 guest</td>
<td>81</td>
</tr>
<tr>
<td>Oracle Enterprise Linux 4</td>
<td>55</td>
</tr>
<tr>
<td>Oracle Enterprise Linux 5</td>
<td>54</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 2.1 guest</td>
<td>61</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 3 guest</td>
<td>59</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4 guest</td>
<td>57</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5 guest</td>
<td>56</td>
</tr>
<tr>
<td>Red Hat Linux 6.2 guest</td>
<td>69</td>
</tr>
<tr>
<td>Red Hat Linux 7 guest</td>
<td>67</td>
</tr>
<tr>
<td>Red Hat Linux 8.0 guest</td>
<td>65</td>
</tr>
<tr>
<td>Red Hat Linux 9.0 guest</td>
<td>63</td>
</tr>
<tr>
<td>SCO OpenServer 5.0 guest</td>
<td>72</td>
</tr>
<tr>
<td>SCO UnixWare 7 guest</td>
<td>75</td>
</tr>
<tr>
<td>Solaris 10 guest</td>
<td>125</td>
</tr>
<tr>
<td>Solaris 8 guest</td>
<td>128</td>
</tr>
<tr>
<td>Solaris 9 guest</td>
<td>126</td>
</tr>
<tr>
<td>Sun Java Desktop System 2 guest</td>
<td>71</td>
</tr>
<tr>
<td>SUSE Linux 10.0 guest</td>
<td>85</td>
</tr>
<tr>
<td>SUSE Linux 10.1 guest</td>
<td>84</td>
</tr>
<tr>
<td>SUSE Linux 7.3 guest</td>
<td>93</td>
</tr>
<tr>
<td>SUSE Linux 8.0 guest</td>
<td>92</td>
</tr>
<tr>
<td>SUSE Linux 8.1 guest</td>
<td>91</td>
</tr>
<tr>
<td>SUSE Linux 8.2 guest</td>
<td>90</td>
</tr>
<tr>
<td>SUSE Linux 9.0 guest</td>
<td>89</td>
</tr>
<tr>
<td>SUSE Linux 9.1 guest</td>
<td>88</td>
</tr>
<tr>
<td>SUSE Linux 9.2 guest</td>
<td>87</td>
</tr>
<tr>
<td>SUSE Linux 9.3 guest</td>
<td>86</td>
</tr>
<tr>
<td>SUSE Linux Enterprise 10 guest</td>
<td>77</td>
</tr>
<tr>
<td>SUSE Linux Enterprise 11 guest</td>
<td>76</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 7 guest</td>
<td>80</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 8 guest</td>
<td>79</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 9 guest</td>
<td>78</td>
</tr>
<tr>
<td>Turbolinux 10 guest</td>
<td>94</td>
</tr>
<tr>
<td>Turbolinux 8 guest</td>
<td>95</td>
</tr>
<tr>
<td>Ubuntu 8.0.4 LTS guest</td>
<td>102</td>
</tr>
<tr>
<td>Ubuntu 8.10 guest</td>
<td>100</td>
</tr>
<tr>
<td>Ubuntu 9.04 guest</td>
<td>98</td>
</tr>
<tr>
<td>Ubuntu 9.10 guest</td>
<td>97</td>
</tr>
<tr>
<td>Ubuntu Linux 5.04 guest</td>
<td>110</td>
</tr>
<tr>
<td>Ubuntu Linux 5.10 guest</td>
<td>109</td>
</tr>
<tr>
<td>Ubuntu Linux 6.06 guest</td>
<td>108</td>
</tr>
<tr>
<td>Ubuntu Linux 6.10 guest</td>
<td>107</td>
</tr>
<tr>
<td>Ubuntu Linux 7.04 guest</td>
<td>106</td>
</tr>
<tr>
<td>Ubuntu Linux 7.10 guest</td>
<td>104</td>
</tr>
<tr>
<td>Windows 2000 guest</td>
<td>22</td>
</tr>
<tr>
<td>Windows 3.1x guest</td>
<td>29</td>
</tr>
<tr>
<td>Windows 7 guest</td>
<td>14</td>
</tr>
<tr>
<td>Windows 95 guest</td>
<td>27</td>
</tr>
<tr>
<td>Windows 98 guest</td>
<td>26</td>
</tr>
<tr>
<td>Windows Me guest</td>
<td>25</td>
</tr>
<tr>
<td>Windows NT guest</td>
<td>23</td>
</tr>
<tr>
<td>Windows Preinstallation Environment guest</td>
<td>15</td>
</tr>
<tr>
<td>Windows Recovery Environment guest</td>
<td>16</td>
</tr>
<tr>
<td>Windows Server 2003 guest</td>
<td>20</td>
</tr>
<tr>
<td>Windows Server 2008 R2 guest</td>
<td>17</td>
</tr>
<tr>
<td>Windows Vista guest</td>
<td>19</td>
</tr>
<tr>
<td>Windows XP guest</td>
<td>21</td>
</tr>
</tbody>
</table>

installing guest operating system with PXE server | 13 |
installing guest operating system, using ISO image | 13 |
ISO image
create for Windows PE 2.1 | 15 |
installing guest operating system | 13 |

K
kernel, avoid installing inappropriate type, Red Hat Enterprise Linux 2.1 | 61 |

L
licenses for guest operating systems | 13 |
LSI Logic SCSI adapter, Solaris 9 | 126 |

M
Mac OS X Server 10.5
installing guest operating system | 41 |
maintenance packs, install for SCO UnixWare 7 guest | 75 |
Mandrake Linux 10
installing guest operating system | 48 |
installing X server | 48 |
Mandrake Linux 8
installing guest operating system | 51 |
installing X server | 51 |
Mandrake Linux 8.1, 8.0
installing guest operating system | 51 |
Mandrake Linux 8.2
installing guest operating system | 51 |
Mandrake Linux 9
installing guest operating system | 49 |
installing X server | 49 |
Mandrake Linux 9.0
installing guest operating system | 50 |
Mandriva Corporate 4
installing guest operating system | 43 |
installing X server | 43 |
Mandriva Linux 2006
  installing guest operating system 47
  installing X server 47
Mandriva Linux 2007
  installing guest operating system 46
  installing X server 46
Mandriva Linux 2008
  installing guest operating system 45
  installing X server 44, 45
Mandriva Linux 2009
  installing guest operating system 44
Microsoft Windows OEM discs, installing guest operating system 13
MS-DOS 6.22
  CPU idle program recommended 30
  installing guest operating system 29
  VMware Tools not available 30

NetWare 4.2 Server
  CPU idle program recommended 124
  installing guest operating system 123
NetWare 5.1 Server
  CPU idle program recommended 122
  installing guest operating system 121
NetWare 6.0 Server
  CPU idle program recommended 120
  installing guest operating system 119
NetWare 6.5 Server
  CPU idle program recommended 118
  installing guest operating system 117
networking
  installing driver in Windows 95 guest 28
  Windows 95 guest 28
  Windows 98 guest 26
  Windows NT guest 23
Novell Linux Desktop 9
  installing guest operating system 53

OEM discs, Microsoft Windows 13
openSUSE Linux 10.2
  installing guest operating system 83
openSUSE Linux 10.3
  installing guest operating system 82
openSUSE Linux 11.1
  installing guest operating system 81
Oracle Enterprise Linux 4
  installing guest operating system 55
Oracle Enterprise Linux 5
  installing guest operating system 54
OSMP, install and configure for SCO UnixWare 7 guest 75

P
  partition virtual disk 12
  PXE installation 13

Red Hat Enterprise Linux 2.1
  avoid installing inappropriate kernel 61
  installing guest operating system 61
  installing X server 61
Red Hat Enterprise Linux 3
  installing guest operating system 59
Red Hat Enterprise Linux 4
  installing guest operating system 57
Red Hat Enterprise Linux 5
  installing guest operating system 56
Red Hat Linux 6.2
  installing guest operating system 69
Red Hat Linux 7
  installing guest operating system 67
  installing X server 67
Red Hat Linux 8.0
  installing guest operating system 65
  installing X server 65
Red Hat Linux 9.0
  installing guest operating system 63
  installing X server 63
root, enable to install VMware Tools on
  Ubuntu 8.04 LTS 102
  Ubuntu 8.10 100
  Ubuntu 9.04 98
  Ubuntu 9.10 97
  Ubuntu Linux 5.04 110
  Ubuntu Linux 5.10 109
  Ubuntu Linux 6.06 108
  Ubuntu Linux 6.10 107
  Ubuntu Linux 7.04 106
  Ubuntu Linux 7.10 104

SCO OpenServer 5.0
  downloading drivers 72
  drive sizes 72
  installing guest operating system 72
  supported SCSI virtual disks 72
  virtual disk recommendations 72
SCO UnixWare 7
  download maintenance packs 75
  install and configure OSMP 75
  install maintenance packs 75
  installing guest operating system 75
screen saver, disable on host 12
SCSI driver support for Windows XP 21
SCSI driver support, Windows XP guest 21
SCSI hard drive, detecting for Solaris 8 129
SCSI support for Solaris 9 126
SCSI virtual disks, supported on SCO OpenServer 5.0 guest 72
Server Core, 64-bit Windows 2008 Server 18
Solaris 10
  installing guest operating system 125
Solaris 8
  detecting the SCSI hard drive 129
  installing guest operating system 128
Solaris 9
  installing guest operating system 126
  SCSI hard disk, use LSI Logic adapter 126
sound adapters on GSX and VMware Servers 12
Sun Java Desktop System 2
  installing guest operating system 71
SUSE Linux 10.0
  installing guest operating system 85
SUSE Linux 10.1
  installing guest operating system 84
SUSE Linux 7.3
  installing guest operating system 93
  installing X server 93
SUSE Linux 8.0
  installing guest operating system 92
  installing X server 92
SUSE Linux 8.1
  installing guest operating system 91
  installing X server 91
SUSE Linux 8.2
  installing guest operating system 90
  installing X server 90
SUSE Linux 9.0
  installing guest operating system 89
SUSE Linux 9.1
  installing guest operating system 88
SUSE Linux 9.2
  installing guest operating system 87
SUSE Linux 9.3
  installing guest operating system 86
SUSE Linux Enterprise 10
  installing guest operating system 77
SUSE Linux Enterprise 11
  installing guest operating system 76
SUSE Linux Enterprise Server 7
  installing guest operating system 80
  installing X server 80
SUSE Linux Enterprise Server 8
  installing guest operating system 79
SUSE Linux Enterprise Server 9
  installing guest operating system 78

T
Turbolinux 10
  installing guest operating system 94
Turbolinux 8
  installing guest operating system 95

U
Ubuntu 8.04 LTS
  installing guest operating system 102
  root, enable to install VMware Tools 102
Ubuntu 8.10
  installing guest operating system 100
  root, enable to install VMware Tools 100
Ubuntu 9.04
  installing guest operating system 98
  root, enable to install VMware Tools 98
Ubuntu 9.10
  installing guest operating system 97
  root, enable to install VMware Tools 97
Ubuntu Linux 5.04
  installing guest operating system 110
  root, enable to install VMware Tools 110
Ubuntu Linux 5.10
  installing guest operating system 109
  root, enable to install VMware Tools 109
Ubuntu Linux 6.06
  installing guest operating system 108
  root, enable to install VMware Tools 108
Ubuntu Linux 6.10
  installing guest operating system 107
  root, enable to install VMware Tools 107
Ubuntu Linux 7.04
  installing guest operating system 106
  root, enable to install VMware Tools 106
Ubuntu Linux 7.10
  installing guest operating system 104
  root, enable to install VMware Tools 104

V
virtual disk
  formatting 12
  partitioning 12
virtual disk recommendations, SCO OpenServer 5.0 72
VMware Server sound adapter 12
VMware Tools
  MS-DOS 6.22 or Windows 3.1x, not available 30
VMware Tools and X server
  Mandrake Linux 10 guest 48
  Mandrake Linux 8 guest 51
  Mandrake Linux 9 guest 49
  Mandriva Corporate 4 guest 43
  Mandriva Linux 2006 guest 47
  Mandriva Linux 2007 guest 46
Windos Server 2008
   Server Core functionality, 64-bit 18
Windows Server 2008 R2
   installing guest operating system 17
Windows Vista
   installing guest operating system 19
Windows XP
   installing guest operating system 21
   SCSI driver support 21

X
X server, selecting
   Mandrake Linux 10 guest 48
   Mandrake Linux 8 guest 51
   Mandrake Linux 9 guest 49
   Mandriva Corporate 4 guest 43
   Mandriva Linux 2006 guest 47
   Mandriva Linux 2007 guest 46
   Mandriva Linux 2008 guest 44, 45
   Red Hat Enterprise Linux 2.1 guest 61
   Red Hat Linux 7 guest 67
   Red Hat Linux 8.0 guest 65
   Red Hat Linux 9.0 guest 63
   SUSE Linux 7.3 guest 93
   SUSE Linux 8.0 guest 92
   SUSE Linux 8.1 guest 91
   SUSE Linux 8.2 guest 90
   SUSE Linux Enterprise Server 7 guest 80
VMware Tools, enable root to install on
   Ubuntu 8.04 LTS 102
   Ubuntu 8.10 100
   Ubuntu 9.04 98
   Ubuntu 9.10 97
   Ubuntu Linux 5.04 110
   Ubuntu Linux 5.10 109
   Ubuntu Linux 6.06 108
   Ubuntu Linux 6.10 107
   Ubuntu Linux 7.04 106
   Ubuntu Linux 7.10 104

W
Windows 2000
   installing guest operating system 22
Windows 3.1x
   installing guest operating system 29
   VMware Tools not available 30
Windows 7
   installing guest operating system 14
Windows 95
   enabling DMA 28
   enabling networking after installation 28
   installing driver for Ethernet adapter 28
   installing guest operating system 27
Windows 98
   booting from floppy disk 26
   enabling networking after installation 26
   installing guest operating system 26
Windows Me
   installing guest operating system 25
Windows NT
   enabling DMA 23
   enabling networking after installation 23
   installing guest operating system 23
   multiple disks, using 23
Windows Preinstallation Environment
   create ISO image for PE 2.1 15
   installing guest operating system 15
Windows Recovery Environment
   installing guest operating system 16
Windows Server 2003
   installing guest operating system 20

Mandriva Linux 2008 guest 44, 45
Red Hat Enterprise Linux 2.1 guest 61
Red Hat Linux 7 guest 67
Red Hat Linux 8.0 guest 65
Red Hat Linux 9.0 guest 63
SUSE Linux 7.3 guest 93
SUSE Linux 8.0 guest 92
SUSE Linux 8.1 guest 91
SUSE Linux 8.2 guest 90
SUSE Linux Enterprise Server 7 guest 80

VMware, Inc.